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Pfedmluva vydavatele
Vizeni ¢tenafi,

dostéva se vim do ruky tak trochu jind kniha o programovéni. Odborné publikace se vétsinou
pysni hloubkou, do které zasahuji, a objemem informaci, které obsahuji. Tato kniha naopak sizi
na Ctivost, prakticnost a obecné zdbavnost. A hned v uvodu oteviené pfiznivd, Ze spousty témat
se ani nedotkne.

S programovinim jsem zac¢inal na zdkladni skole pfed skoro tficeti lety. A jedna z mych prvnich
myslenek samoziejmeé byla napsat si hru. Tehdy jsem zvladnul nanejvys jednoduchy kviz, ale to mi
nebrénilo snit. Postupem ¢asu jsem se zlepSoval a ucil se toho vic a vic, ale zacal jsem fesit redlné
problémy, a na hry uz nebyl ¢as. Kdyz jsem s ur¢itou technologii zacinal, Cerpal jsem obvykle z né-
jaké chytré knihy, kterd hldsala, Ze obsahuje vie, co potiebuji védét. Jd se ponofil do jejiho ¢teni
a nikdy ji nedocetl, protoze po pir kapitolach suché teorie mé to pfestalo bavit.

Tato kniha je jind. Netvrdi, Ze vds nauéi vée o Unity. Pravé naopak, hrdé se hldsi k tomu, Ze neobsa-
huje ani solidni zaklady, natoz kompletni popis celého enginu. Jeji pfednosti je néco jiného, podle
mé daleko zdsadnéjsiho. Je velmi ¢tivd a ndzornd. Ukazuje, jak zacit. Zacéne jednoduchym zadanim
a snazi se ho naplnit. Vysvétluje, co je potieba k dosazeni cile. Nestravite kapitoly ¢tenim teorie,
abyste se na konci knihy dozvédéli, Ze vim to moznd nékdy k né¢emu bude. Naopak. Kniha za¢ina
od toho, co je nasim cilem, a pak teprve fesi, jak ho dosdhnout. P¥ipadné jak cil zménit. Protoze
v redlném svété neexistuje perfektni zaddni. Existuji celé vyvojarské tymy, které pracuji roky na
funkcich, které se nakonec ukdzi jako okrajové a zbytecné slozité, a jsou zahozeny. A pfitom by
mnohdy stadilo se nad zadinim vcas zamyslet a upravit ho. V knize naleznete momenty, kdy se
fungovini hry zméni, protoZe naplnéni pivodniho plinu by bylo zbyte¢né slozité a nakonec by ani
nemuselo fungovat dobfe. Stejné jako v redlném Zivoté do sebe v knize vSe nezapadd na prvni po-
kus. Objevuji se problémy, které je tfeba fesit, a kniha ukazuje jak. I diky tomu vés ,vtahne do déje®.

Pro koho je tedy kniha uréena? Neni to publikace, kterou bude mit programator her na policce,
a po které sihne, kdyz nebude védét, jak se néjaka obskurni konstrukce pouziva. Je to kniha, kterou
zhltnete, pokud si chcete naprogramovat néjakou hru a nevite, jak za¢it. A nemusi byt jen pro ty,
ktefi uz umi programovat. Ukdzky jsou velmi ndzorné a jednoduché. Osobné mé prekvapilo, jak
milo a jak jednoduchy kéd vlastné staci k tomu, udélat si vlastni hru. Muze to tak byt i vhodna
kniha pro vechny, ktefi pfemysli, jak zalit s programovanim viibec. Za mélo price hodné zibavy.
A jak s tim jednou za¢nete, uz vis to jen tak nepusti.

Pteji vim zdbavné Cteni a té$im se na spousty novych Indie her, u jejichZ zrodu bude pravé tato
kniha stit.

Michal Hrugecky, CZ.NIC
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— 1 Uvod

1 Uvod
1.1 Prochazka

Tohle je kniha o programovini her v Unity enginu a je uréend tém, kdo by se chtéli s Unity seznd-
mit, ale nevédi, odkud zadit.

Nebude to uéebnice, kde bych vyjmenovaval véechna okna, tla¢itka a polozky v menu. Budu psit
program a co budu potfebovat, to pouziju a okomentuju. Takova spole¢nd prochdzka, mozna
trochu upovidani.

Expert

Nejsem zddny expert na Unity, na druhou stranu programuju vice nez Ctyficet let a leccos z toho,
co jsem programoval, byly hry, tak véfim, Ze mdm trochu nadhled a Ze to pijde. A Ze pokud mi
néjaka znalost bude chybét, tak si ji dokazu najit. Vzhiru do toho!

Varovani

Budu ukazovat vyvoj programu nebo programi a to zahrnuje i zmény pldni a nesplnénd pred-
sevzeti. Mohl bych se jim vyhnout a ukdzat vim jen vysledek, kde vSechno pékné vychdzi, ale
pfipadd mi, Ze to bloudéni a pfehodnocovéni k vyvoji programu patii. Navic mi to dovoli ukdzat
vic mozZnosti, jak néco udélat, nez jen jedinou spravnou. A nakonec, chceme se néco naucit, takze
cesta je cil!

Hry

Kdyz fikim hry, tak tim nemyslim Sachy ani Hleddni min, i kdyZ to by slo v Unity naprogramovat
taky. Pdjde mi o hry, ve kterych se néco hybe, chodi, 1ét4, pada, plave.

Herni smycka
Takové hry maji v sobé vlastné model celého herniho svéta — udaje o tom, kde je jaka postavicka
piekdzka, véc... a celd hra potom probihd v néfem, ¢emu se historicky fikd herni smycka, tedy

neustdlé opakovani dvou kroku:

e pohni vSemi objekty svéta

e vykresli svét

15



— 1 Uvod

Herni objekt

Ano, ty postavicky, pfekazky, véci... prosté véechno, co ve hie ma néjaky vyznam, se shrnuje pod
oznaleni herni objekt.

1.2 Unity engine
Cizi kod

Fred Brooks v roce 1987 napsal ¢lanek ,No Silver Bullet — Essence and Accident in Software En-
gineering®, kde se zamysli nad tim, jestli néco dokdze v prabéhu deseti let fadové urychlit vyvoj
software (nebo ho urychlovat tak, jak se zrychluje vykon hardware) — a dochézi k zavéru, Ze ne.

Softwarové projekty uz tehdy mély zpozdéni, nedodrzovaly rozpocet a trpély podobnymi neduhy.
Clanek postupné prochdzi moznosti, které by mohly pomoci, véetné automatického programova-
ni (pamatuju, byl to hit) nebo objektového programovéni (to uz dnes pouziva snad kazdy) a po-
stupné dochézi k tom, Ze Zddnd z téch novych technik nedokize fadové urychlit vyvoj programi,
prosté proto, Ze vyvoj programd je v principu slozity (to je ta ,essence z ndzvu ¢lanku).

Ale pfi pohledu zpét vidime, Ze vyvoj programii dnes rychlejsi je; tfeba program napodobujici ka-
pesni kalkulacku, s tlacitky a ovladdnim mysi dokdze student prvniho ro¢niku vysoké skoly napsat
za hodinu, mozna méné. A je to diky moznosti, kterou autor ¢linku nezapocital — moznosti pouzit
cizi kéd! (Slovem kéd tady oznacuji i dile budu oznacovat program, cely nebo &ist, ve zdrojovém
tvaru nebo néjak pielozeny.)

KdyZz zminény student piSe program ovlddany my$i, tak nemusi fesit komunikaci s mysi, at uz
pomoci sériového rozhrani RS232 (dfive) nebo pomoci USB (dnes), protoze o to se stard opera¢ni
systém. A pokud jiny student chce ve své webové strince vykreslovat trojrozmérné animace, pou-
Zije na to néjakou knihovnu (nebudu jmenovat, ale je jich vic).

Pouzivani ciziho kédu s sebou nese spoustu problém, ale o tom ted nechci mluvit.

Knihovna, framework, engine

Knihovna je jedna z moznosti, jak sdilet a znovu-pouzivat dfive napsany kéd.

Vétsina programovacich jazyki umoziiuje do zdrojového kédu zaclenit dalsi kéd, budto ve formé
zdrojového kédu nebo vysledek piekladu a tak stali piislusné funkce (pfipadné data, definice

tiid a podobné) vlozit do néjakého zdrojového kédu nebo projektu nebo balicku (rizné ndzvy
v rliznych programovacich jazykéch), ktery budeme dale pouzivat; moznd my a moznd i nékdo
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— 1 Uvod

jiny. Takovému (zdrojovému) kédu nebo mnoziné (zdrojovych) kédi potom fikdme knihovna.
Z knihovny si vytihneme, co se nim hodji, a také muzeme klidné pouzit vice knihoven najednou,
tfeba jednu pro kresleni a druhou pro komunikaci po internetu.

Framework funguje v jistém smyslu naruby — zatimco u knihovny ,hlavni program® pieme my
a vybirdme si, co pouzijeme z cizich knihoven, u frameworku je to tak, Ze funguje sim a my pou-
ze mizeme dopliovat nebo ménit nékteré funkce. Treba kdyz v .NET Frameworku vytvofime
WinForms-aplikaci, nemusime napsat ani fddku kédu a pfesto mdme program, ktery jde spustit,
zobrazi okno, které se dd zvétSovat a pfesouvat mysi i klavesami, zobrazuje svou ikonku v seznamu
bézicich program, zobrazuje se ve spravci uloh a ma fadu dal$ich funkei. A pokud chceme, mu-
Zeme pozménit jeho funkci, pomoci které na zacatku vytvafi obsah svého okna a pfidat tam néjaka
tlacitka nebo jiné komponenty a mizeme také pfidat funkee, které budou reagovat na uddlosti,
a tim vlastné zafidit, Ze ten program bude délat to, co chceme. Ale hlavni program jsme méli od
samého zac¢dtku hotovy a jenom dopliiujeme a vylepsujeme. A hlavni program jsme nenapsali my,
ale autofi frameworku.

Herni engine (a Unity neni jediny (pamatuje nékdo AGI? Treba King‘s Quest od Sierra Online?),
viz tfeba Unreal Engine, Cry Engine nebo Godot) je povahou spi§ framework.

Obvykle zahrnuje vykreslovani (protoze to je spousta price a herni navrhdfi maji jiné zdjmy),
detekci kolizi (abychom poznali, kdy na sebe objekty narazily), fyziku (aby na objekty mohly
plisobit sily, setrvacnost a dal§i objekty), herni smy¢ku plus ndstroje na vytvafeni a editaci her-
niho svéta pfiddvinim a nastavovinim hernich objektl. Vétsina hernich enginii dovoluje také
programovini, at uz ve svém vlastnim jazyku nebo v nékterém z univerzalnich jazyka. V Unity lze
programovat v jazyku C#.

Dostupnost, licence

Unity engine je ke stazeni ze stranek spole¢nosti, dostupna je jak bezplatnd, tak placend verze.
Bezplatna verze je omezend pro osobni pouZiti a pro spole¢nosti se ziskem do urcité vyse.

Verze

Jako kazdy software, ktery se pouzivd, i Unity engine se vyviji. To znamend, Ze pokud si stihnete
nejnovéjsi verzi, za ¢as uz nebude nejnovéjsi. Novéjsi verze miize byt lepsi (proto to délaji), ale
Unity nemusi umét bez problému oteviit projekt, ktery jste vytvofili v jiné verzi (viz ta moje po-
zndmka o problémech s pouzivinim ciziho kédu). Takze (obzvlast pokud cheete vytvafet néjakou
hru spole¢né s dal§imi lidmi) je dulezité domluvit se, jakou verzi Unity budete pouzivat.
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1.3 Zdroje informaci

néj$i a dal§i nej- je Unity Manual od autort Unity na strance https://docs.unity3d.com/Manual/,
nezapomeiite si vlevo nahofe vybrat verzi Unity, o které chcete informace. MiiZete si ho i stihnout

jako zip.
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2 Zaciname
2.1 Zacdiname

V téhle kapitole se chci podivat na to, jak vytvofit novy projekt a jak vypadd pracovni prostiedi.
Minimdlni cil je vytvofit néco, co se bude alespori trochu hybat.

Kdyz zalindm, tak bych si mél rozmyslet, jakou verzi Unity chci pouzivat. Unity uz nékolik let
disponuje nastrojem Unity Hub, pomoci kterého muzete mit piehled o viech projektech, ale také
o viech instalovanych verzich Unity (ano, lze mit nainstalovino nékolik verzi soucasné). Unity
Hub mizeme pouzit k instalaci novych verzi a vytvafeni novych projekti. A v neposledni fadé pod
zélozkou LEARN nabizi ke stazeni ukdzkové projekty i odkazy na dal§i informace.

> Pojes s Installs were | IR
Leom
20192611

V tuto chvili mdm nainstalovanou verzi 2019.2, ale protoze verze 2020 jsou dostupné teprve jako
pre-release, zistanu u ni.

Jdu tedy vytvofit novy projekt a budu pouzivat Unity 2019.2. Na zdlozce Projects mackam tlacit-
ko NEW a kdyz si chci vybrat kliknutim na sousedni $ipku dolu, nabizi vybér, kterou verzi Unity
chei pouzit, mdm jedinou, tak Zidné rozhodovini. Na to vyskoci okénko, kde si vybirime typ
projektu, nazev a umisténi na disku:

B
‘@
*
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— 2 Zadlindme

Nastavuju jméno UK, neuvizené mackim Enter a tim startuje Unity. Budu mit projekt umistény
v kofeni disku C:. Start Unity chvili trvé, nenechte se tim znepokojit.

2.2 Prostredi Unity

U BN IR
i

izl ® [l il s |

Main Camera
_IDirectional Light

Vime, ze Unity slouzi k vytvafeni her, vime, Ze hra obsahuje néjaké herni objekty, které se opako-
vané (vnucuje se ,pravidelné®, ale to neni pravda!) pohybuji a vykresluji. To, jak se budou objekty
vykreslovat, urtuje kamera, aby bylo (kamerou) néco vidét, potfebujeme svétla, a tomu celému se
i{kd scéna. Takze okno Hierarchie (vlevo) zobrazuje strukturu scény (scén muiZe byt v projektu
vice, hra ma obvykle kromé vlastniho hrani i néjaky zacatek, konec a dalsi ¢sti), to velké okno
uprostied zobrazuje editor scény, zatim obsahuje pouze kameru a jedno svétlo, okno Inspektor
napravo zobrazuje vlastnosti vybraného objektu a panel dole zobrazuje konzoli nebo dalsi Assets,

pozdéji.
A nahofte vidime tlacitka Play, Pause a Step pro spusténi hry — tak zkusime stisknout Play.

Na to uvidime pohled kamerou:
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a jinak nic zajimavého, protoze v nasi hie zatim nejsou zddné herni objekty. Béh ukoncime opé-
tovnym stisknutim tlacitka Play (nebo klavesovou zkratkou Ctrl-P).

Mohli jsme si také vS§imnout, Ze se zménila vybrana zalozka nad obrdzkem hry — zatimco pfedtim
byla vybrana zdlozka Scene, béhem béhu byla vybrand zdlozka Game. Kdyz se budeme chtit né-
kdy podivat, jak vypada nase scéna z pohledu kamery, nemusime hru spoustét a sta¢i se pfepnout
zalozkou.

Pridat herni objekty

Pojdme ale do nasi hry pfidat néjaké objekty. Kdybychom programovali opravdovou hru, asi by-
chom si objekty nejdfive vytvofili-vymodelovali, tfeba v programu Blender, spousta objekt se
také da koupit nebo bezplatné stahnout, ale protoze nechceme odbocovat, pouzijeme jednoduché

geometrické objekty, které jsou v nabidce Unity.

Kdyz klikneme na ikonku v pravé ¢asti okné Hierarchie, vyskoéi ndm menu, kde si vybereme, Ze

chceme do scény pridat krychli:
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File Edit Assets GameObject Component Window Help

# Scene
| shaded zll2o ]| ® [ iz o]

2 SampleScene
|_IMain Camera Set Active Scene

_ I Directional Light
v & Save Scene

Save Scene As
Save All

Unload Scene
Remove Scene
Discard changes
Select Scene Asset
Add New Scene

Create Empty
3D Object
2D Object Sphere
Effects Capsule
Light Cylinder
Audio Plane
Video Quad
ul Text - TextMeshPro
Camera Ragdoll...
Terrain
Tree

B " Wind Zone
Bl 3D Text

| Clear || Collapse | clear on Play | Clear on Build | Error Pause | Editor = | C

a nade scéna od téhle chvile obsahuje krychli, v okné Hierarchie i v editoru scény. A protoze je
vybrand, mizZeme vidét a ménit jeji vlastnosti v okné Inspektoru napravo.

File Edit Assets GameObject Component Window Help

# Scene
| Shaded “ll2l] e (w2 7o) =
v € samplescene* R ——
e Cormera - R —
|/ Directional Light o

Y

o | o o
o o o

ze
Element 0 @ Default-Material o

Cast Shadows
Recelve Shadows [
Contribute Global I_]

Recelve Global Il
v roves

Light Probes

Refection Probes

Anchor Override [None (Transform) o
v Addional Settings

Motion Vectors

Dynamic Occusioniy!

¥ i ¥Box Collider EXS

| clear || ollpae | ciear on ply | clear on puid | eror Pause | edior =)

Edit Collider
Is Trigger W]
Material [None (Physic Materia) | ©
e -
i com— Y c— c—
Size
- o— | ro— ro—

Default-Material
> Shader [ Standard

Add Component
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Pokud se podivime na pohled kamerou, vidime nasi krychli jako bily &tverec uprostied zébéru:

Maximize On Play | ute Audo | ySync | Stas | Gizmos -

Pridejme si do scény jesté jeden objekt, tentokrit to bude rovina (Plane), kliknutim si vybereme
krychli a v inspektoru v ¢dsti Transform ji zménime Y-slozku udaje Position z 0 na 2:

T — [P sllll ® [l #o| LRSS

' @ samplescancr —— e P —
- Main Caera - Tog (tasses 1] Laver
|_Directional Light x
p Cbe
 Plane

¥ Mesh Renderer

¥ Materials

T

ODerault-Material °

Sl
Recelve Shadows (4
Contribuite Global L]
Recelve Global Il greprobes_____¢]

¥ robes

Light Probes
Reflection Probes (Bentrebes 1)
Anchor override. o

v Addrional Settings
Motion Vectors
Dynamic Occlusioniyl

Edit Colider
LS o
i °
Center.
b O\ ] O —
size
b E—

Default-Material 2
> Shader  standard o

(L Addcomponent ]

(TR

| Clear || Collapse | Clear o Clear on Build | Error Pause | Editor - 7 1 ¥Box Collider

MiiZeme si viimnout, Ze kostka vrhi stin.

Pokud ted spustime hru tlacitkem Play...
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...kromé pfepnuti na pohled kamerou se nedéje nic. No, nic jsme nenaprogramovali, co by se mélo
dit... ale mozna nékdo pfece jen v koutku duse doufal, Ze uvidi néco pékného...

2.3 Fyzika

Jedna z uloh, které herni enginy fesi za autory her, byva detekce kolizi a ,fyzika®, tedy to, Ze objekt
muZe mit néjakou rychlost, néjakou hybnost, néjakou pruznost a pokud by mél p#i pohybu projit
jinym objektem, tak neprojde, piipadné se odrazi nebo jinak zméni svou rychlost, piipadné se
otodi a podobné.

Tohle vsechno Unity umi, jen si musime fict, Ze to chceme.
Vésak na vlastnosti

Herni objekty v Unity samy od sebe neumi nic a slouzi jako vésiky, na které navésujeme dalsi
vlastnosti, kterym se v Unity fikd komponenty. KdyZ jsme pomoci menu do nasi scény piidali
krychli a rovinu, tak ty uzZ mély nékteré komponenty nastavené, takze v Inspektoru mizeme vidét,
ze nase krychle obsahuje komponentu Mesh Renderer, kterd se stard o vykreslovani a kompo-
nentu Box Collider, kterd fesi kolize hranolu, na rozdil od komponenty Mesh Collider, kterou
obsahuje nase rovina.

Pokud tedy chceme (chceme!), aby se krychle pohybovala (padala), potfebujeme piidat kompo-
nentu, kterd se o to bude starat: Add Component - Physics — RigidBody:
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l Dynamic Ocdusion |y ! Dynamic Occlusionjy
;ﬁ:\ YWE Q] N AT Gy ER
. < Component 7 < Physics
TR B e T Character Controller -
Mate | e Mate ~ e
Cent Audio > e \ Character Joint
¥| Effects i % | Cloth -
Size| Event > Size & Configurable Joint
e X Layout N X & Constant Force ]
X[T J¥ [T 2 [T ] Mesh B ﬁ %, & Fixed Joint ﬁ B,
Miscellaneous DY - ¥ Hinge Joint -
J st e i) @ = 2 Navigation > e— - | Mesh Collider —
»> Shader | standard . Physics 2D >
) Sphere Collider
[ Add.Component ] Playables > § Spring Joint
= Rendering >| i \@Terrain Collider
= Scripts e Q) Wheel Callider vn

Kdyz ted stiskneme Play, kostka spadne a zarazi se o objekt roviny, protoze oba maji komponentu
pro detekei kolizi.

Vylepseni

Cely ten pad trva jen chvilicku a na tom, jak vykonny mdte pocital, zalezi, kolikrit se béhem
té doby scéna vykresli. Pokud si ho chceme trochu vic uzit, miZzeme do scény pfidat jesté jednu
krychli, trochu vys a trochu stranou, aby nezfistala stit na prvni krychli, ale padala dal:

Jeji Position.Y nastavime na 5, pfitom nam krychle zmizi z okna editoru, ale stali zazoomovat
kolec¢kem mysi — a Position.X nastavime na 0.9 (jako desetinny oddélova¢ mizeme pouzit ¢arku

i te¢ku), aby nova krychle pfi pddu jen zavadila o starou krychli.

Pokud bychom ted stiskli tlacitko Play, nové krychle ziistane na misté, protoze jsme ji nenastavili,
Ze mé padat, takze jesté piidat komponentu Rigid Body — a pada a kutdli se!

TakZe mame prvni projekt a hybe se to!

2.4 Vlastnosti, parametry atributy

Vzhled i chovani objektd a komponent mizZeme ovlivnit nastavenim jejich parametrti. V samot-
ném prostiedi Unity to mizeme udélat pomoci panelu Inspektor, ale az zaéneme programovat,
muZeme vlastnosti nastavovat i dosazenim ze skriptu (kédu, ktery bude soucasti hry).

Material

Zactnéme tim, jak nase dvé krychle vypadaji. A ten zaldtek jesté zaénéme tim, Ze je pfejmenujeme,
protoze ted se jmenuji Cube a Cube (1). Pfejmenovini je snadné, staci v panelu scény vybrat ob-

27



— 2 Zadindme

jekt, stisknout F2 a zménit jméno. Pojmenoval jsem je Dolni a Horni, bez diakritiky. Analogicky
jsem rovinu Plane pfejmenoval na Rovina.

Vsechny tfi objekty jsou bil¢, kdyz se podivime do Inspektoru, vidime, Ze Rovina pouzivd vychozi
materidl.

v .| ¥Mesh Renderer K-8
¥ Materials
Size 1 |
Element 0 | @ Default-Material | @
¥ Liahtina

Kdyz klikneme na ikonku napravo od ndzvu materiilu, vysko¢i ndm okénko pro vybér materidlu,
ale my si nejdfive vytvofime vlastni materidl. V dolnim panelu, pfepneme na zilozku Project a na
polozce Assets (to jsou vSechny ,véci“ patiici k projektu — obrizky, zvuky, skripty — a také materi-

aly) pravym tlacitkem vyvolime menu a zvolime Create — Material:

Novy materidl hned pfejmenujeme na Hmota (nepisu mezindrodni program a &eské jméno na

prvni pohled odlisi moje prvky od standardnich) a protoze je vybrany, tak Inspektor zobrazi jeho

vlastnosti:
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Folder
C# Script
Shader >
Create Testing >
Show in Explorer Playables L
Open Assembly Definition
Delete Assembly Definition Reference
Rename TextMeshPro >
Copy Path Alt+Ctrl+C
By Scene
Open Scene Additive Prefab Variant
Import New Asset... Audio Mixer
Import Package > -
: & S 3 Material
b Lens Flare
Find References In Scene
e Render Texture
elect Dependendes Lightmap Parameters
Refresh Ctrl+R Custom Render Texture
Kampor Sprite Atlas
yFroject W] Reimport Al Sprites >
Create ~| E
Extract From Prefab
E QFEVOI’I‘!! An!mat?r Controller
©|AllMaty  Run APl Updater Animation
LA T —— Animator Override Controller
O Al pref Avatar Mask
Open C# Project
Timeline
& Scenes Scenss Signal
+ i Packages Physic Material
Physics Material 2D
GUI Skin
Custom Font
Legacy >
UlElements Editor Window
[ Brush I
L e Terei e =
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, kde vidime, Ze miiZeme nastavit vlastnosti jako prihlednost nebo
lesk — nebo barvu! Bily obdélnicek napravo od vlastnosti Albedo pfi

® kliknuti vyvold okno pro vybér barvy:

Rendering Mode Opague v
Main Maps
~ oAbedo )2

@Metallic O [0 |

Smoothness e [0.5 |

~ oNormal Map _

da
nt
 oHeight Map I ,

©Occlusion
 @Detail Mask i
Emission (m] h r
offet Y o— A E— 4 R
Secondary Maps
 oDetail Albedo x2
~ Normal Map .
Ting x v
offset | Com— A I—
Ly et
Forward Rendering Options
Specular Highlights (¥
R “ Abychom nastavené vlastnosti pfenesli
Advanced Options

rap——— na objekt, vybereme ho, a budto v In-
pepie Seea e ] spektoru u polozky Material kliknutim

Himots = S = vyvoldme nabidku materidlii a vybere-
F | me si nebo (snazsi) pozadovany mate-

A 255 ., ) v , v 7
y { o ridl v dolnim okné chytime a pfetdhne-
exadecimal
— _ me na vlastnost Material nebo pfimo
@ click to add new preset na Objekt ve scéné:
o

0| | shaded MIENTER D INETY | % | m | Gizmos (- | @Al \
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Bylo by samoziejmé lepsi novy material nevytvéfet takhle v kofeni pfihradky Assets, ale udélat si

zvla§tni piihradku na materidly, ale pro zacdtek nim to nevadi.
Fyzikalni material
Material, ktery jsme si vytvorfili v minulé kapitole, nim pomohl zménit vzhled. To odpovida tomu,

Ze jsme tento materidl pouzili v komponenté Mesh Renderer, kterd ma na starosti zobrazovani.
Umime si ale pfedstavit i materidl, u kterého neni dulezity vzhled, ale fyzikalni vlastnosti, tfeba

pruznost. Takovy materidl si zase mizZeme vytvofit a pfidat do Assets:

D

Directional Light

__/Rovina

Horni

Create:

Show in Explorer
Open

Delete

Rename

Copy Path Alt+Ctri+C

Open Scene Additive
Import New Asset.
Import Package

Export Package.

Find References In Scene
Select Dependencies

Folder

C# Script

Shader

Testing

Playables

Assembly Definition
Assembly Definition Reference
TextMeshPro

Scene

Prefab Variant

Audio Mixer

Material

Lens Flare

Render Texture
Lightmap Parameters

Refresh Ctri+R Custom Render Texture
Hemboly Sprite Atlas
@ Project Reimport All Sprites >
Creats -
‘, QFE‘,L Extract From Prefab Animator Controller
©lAl  Run API Updater. aatcy —
oAl Animator Override Controller
Al Update UlElements Schema Avatar Mask -
e Open C# Project g @ Project
&3 Scenes R r— Signal | create -
» GaPackages el v +_;Favorites Assets
All Materials
Physics Material 2D %Aﬂ S
odels ——
GUI Ski
" (© All Prefabs
Custom Font
Leoacy, ’ = Assets
UlElements Editor Window (& Scenes Scenes Hmota
Brush | » falPackages

Nastavime mu jméno, tieba Guma a zkusime zmeénit jeho vlastnosti tak, aby pruzil.

Kdyz si materidl Guma vybereme, miizeme v Inspektoru nastavit jeho vlastnosti

@ Inspector

=

Guma

Dynamic Friction 0.6 |
2 Static Friction 0.6 |
Bounciness 0 |

Friction Combine
Bounce Combine
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Protoze odrazivost (stejné jako tfeni) zdlezi na odrazivosti obou stfetdvajicich se objekti, miizeme
nastavit, jak se tyto vlastnosti maji kombinovat. Zatim ponechdme hodnotu Average ¢ili pramér
a pfifadime tento materidl objektu Rovina, opét pfetazenim materidlu na objekt.

Vysledny pohled na komponentu Mesh Collider objektu Rovina vypada takto:

| ¥ | ¥ Mesh Collider Q= e
Convex o
Is Trigger

Cooking Optons

Material =£GUma [c]
Mesh @l Flane o]
° Hmota [T
» Shader | standard 3

[ Add Component ]

Kdyz stiskneme tlacitko Play, vidime, Ze kosti¢ky dopadaji jinak. Ale pfiddme fyzikdlni material
Guma jesté zbylym objektim Horni a Dolni a ted kosticky skidcou tak dlouho, dokud jedna
z nich nepfepadne pies okraj Roviny a nezfiti se dolti. Odrazivost 1, tedy 100 procent, je pfece
jen piilis.

2.5 Kamera

Pokud chceme zménit pohled na nasi scénu, upravime nastaveni kamery.

Jakmile kameru vybereme, objevi se nim v okné scény pod-okénko Camera Preview, kde mizeme
vidét, jak vypada pohled vybranou kamerou. V Inspektoru mizeme nastavovat vlastnosti kamery

jako zptisob projekee (Projection) nebo co se mé zobrazovat tam, kde neni nic (Clear Flags).

My ale chceme kameru spiSe posunout vy$ a pootocit, k tomu slouzi tladitka pod listou menu
pouzitelnd pro manipulaci se vSemi objekty,

File Edit Assets GameObject Componer

B + BEARIRIES

kterymi postupné ovlidime posunuti pootoceni, zvétsovani a dalsi.
Takze chceme-li kameru posunout vys a potom pootocit tak, aby sméfovala do stfedu objektu

Rovina, mizeme na to pouzit ndstroj pro posouvini a ndstroj pro pooticeni, pfipadné sdruzeny
nastroj druhou ikonkou zprava.
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Po chvili mozna skonc¢ime u toho, Ze vidime podivné kfivy pohled, ktery se ndim nedafi srovnat,
takZe opustime ndstroje a pozici a Ghly natoCeni kamery nastavime v okné Inspektoru tak, Ze do
vlastnosti (X, Y, Z) Position dosadime hodnoty 0, 4, -10 a do vlastnosti Rotation hodnoty 15,
0,0.

Pozndmka: Asi vds uz napadlo, Ze kdyz nastavujeme smér pootocenim podle 171 os, zdlezi na tom, v ja-
kém poradi se ta pootocenti budou provddet (jestli vds to nenapadlo, tak si to zkuste pr’edsta‘vit). Unity
takto zadané sméry pootdci postupné podle osy X, podle osy Y a podle osy Z, v tomto poradi.

Miize se ndm u toho stit, Ze pohled v okénku nihledu Camera Preview bude vypadat jinak nez
pohled po pfepnuti na zilozku Game nebo ve vlastni hfe. Pokud se to stalo, pfepnéte se na zdloz-
ku Game a posuvnik Scale posuiite az na levy okraj:

€ Game

4+ | Free Aspect #| Scale (——— %

2.6 Konec zacatku
Pokud jsme dosli az sem, méli bychom mit hrubou pfedstavu o tom, jak se s Unity pracuje, i kdyz

vét§ina moznosti byla popsand nepofddné a celd fada jich nebyla ani zminéna. Ale na né se podi-
vame v dal§ich ¢4stech.
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3 Pokracujeme
3.1 Navrh hry

V minulé ¢ésti jsme vytvofili néco, co se nakonec zobrazovalo a chvili pohybovalo a na ¢em jsme
mohli vidét zakladni nistroje, kterymi disponuje Unity. V této ¢dsti bychom se chtéli vénovat dal-
$im ndstrojum i dalsim moZnostem téch nastroju, které jsme uz vidéli a na to bychom potiebovali

Tyranosaurus Rex

V osmdesitych letech byl populdrni poéita¢ Sinclair ZX81, alespoii J. K. GREYE SOFTWARE
do doby, nez pfisel jeho jesté populdrnéjsi naslednik Sinclair ZX
Spectrum. ZX81 mél 1kB paméti a dal se k nému pfipojit mo- m

dul s dal§imi 16kB a na téchto 17 kB paméti fungovala hra 3D
Monster Maze, ve které hra¢ prochizel trojrozmérnym bludi§tém
a snazil se nepotkat vy$e uvedenou obludu.

MONSTER MIAZE

Kdybychom chtéli takovou hru naprogramovat dnes, navic pomoci
Unity, tak budeme potfebovat:

A) hrdinu a jeho pohyb pomoci sipek nebo mysi
B) bludisté, které bude hrice omezovat v pohybu GAMESTAPE 4
C) kameru, kterd bude sledovat hrdinu for 16K ZXB1
D) tyranosaura, ktery bude bud'to setrvavat na jednom misté nebo
se bude pohybovat a tedy bude mit néjakou umélou inteligenci  (zdroj: https://en.wikipedia.org/

(AI) wiki/File:3DMonsterMaze.
E) néco, co bude hra¢ hledat, budto vychod nebo néjaké bonusy, JKGS.tape-cover,jpg)
aby mél divod se v bludisti pohybovat
F) zvuky?

G) Svétlo, kterym bude svitit hrdina?
H) Vytvéfeni bludisté programem, aby nebylo vzdycky stejné?
I) jesté néco, co mé ted nenapada.

3.2 Novy projekt

Vytvofime si novy projekt. Pouzijeme na to Unity Hub, typ projektu bude 3D, nizev TRex a ces-
ta tam, kde ho chceme mit uloZeny. Projekt vytvofime tlacitkem CREATE.

Do projektu zase vlozime objekt Plane a pojmenujeme ho Rovina:
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B EIETED)

|/ Main Camera Set Active Scene
| Directional Light

Save Scene
Save Scene As
Save All
Unload Scene
Remove Scene
Discard changes
Select Scene Asset
Add New Scene
[t > Create Empty.
| ject > Cube
> Sphere
Effects > Capsule
Light > Gylinder
Audio > [ Plane
Video > Quad
ul > Text- TextMeshPro
Camera Ragdoll..
Terrain
Tree
Wind Zone

& Project
3D Text

| create <|
- Faunritac Accate

o 10
v Favorites | Assets
e

Q

b i B

3.3 Pohyb, skripty, ovladani

Do hry potfebujeme néco, co bude representovat hrace. U toho bychom se méli rozhodnout, jestli
hrdina bude viditelny nebo ne; neviditelny hrdina neni Zddné kouzlo, v nékterych hrach se hra¢
divd z pohledu hrdiny a tedy hrdina sim neni vidét.

Je to rozhodnuti, takze neni Zddna spravna odpovéd, rozhodneme se tedy do zacdtku, ze hrdina
vidét bude. A kdyz nd§ hrdina bude vidét, vybereme mu jesté néjaky tvar, pro jednoduchost zvoli-
me krychli (Cube), pfiddme do scény a pfejmenujeme na Hrdina.

Pozndmka: V dalsim textu budeme nékdy psit o hrdinovi obecné (s malym ,h*) a nékdy o Hrdinovi
jako konkrétnim objektu (s velkym ,H), i kdyZ ta hranice nemusi byt vidycky ostrd, a podobné u dalsich
objektii. Snad to nebude rusit.
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Abychom vidéli, jak je krychle-hrdina otocend, tak
k ni jesté pfiddme kouli (Sphere). Kouli pfiddme tak,
Ze pfiddvaci menu vyvolime na objektu Hrdina, takze
nové vytvofeny objekt bude soudisti hrdiny a budou
se ho tykat pfesuny, skripty, kolize a dalsi.

Nové vytvofené kouli nastavime posunuti a velikost
(vlastnosti Position a Scale komponenty Transform)

w Lope i

¥ Sphere | [] static =
Tag | Untagged 4| Layer | Default ™|
¥ A, Transform FES
Position X |0.5 ¥ (0.5 Z|0
Rotation X |0 Y0 Z|0
Scale X |0.5 ¥ (0.5 Z|0.5
-l T o PR, .~ [

= Hierarchy
| create ~| (@Al

v € sampleScene* =
__IMain Camera
|_IDirectional Light
_IRovina

Copy
Paste

Rename

Duplicate
Delete

Select Children
Select Prefab Root

Create Empty

3D Cbject 5 Cube
2D Object > Sphere
Effects > Capsule
Light > Cylinder
Audio > Plane
Video > Quad
ul > Text - TextMeshPro
Camera Ragdoll...

Terrain

Tree
Sa[proeck Wind Zone

| Create |
v [ Favorites | Assets S0ilext
() All Materials
A Al Ml — L |

a aby to bylo dobfe vidét, tak krychli i kouli pfifadime néjaky materidl, materidly si pro pofddek

pojmenujeme MHrdina a MBudka:

# Scene

o | Gizmos +

Kdyz chceme ovlddat hrdinu tak se musime nejdfive néco dozvédét o skriptech, protoze po-

hybovat budeme pomoci skriptu, ale také o ovladani, neboli o tom, jak &ist uzivatelovy vstupy.

Postupné.
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3.4 Skript
Uz jsme slyseli, ze se v Unity da programovat. A uz jsme u toho!

Programovat budeme v jazyku C#, hodi se mit nainstalované Visual Studio nebo jiny néstroj, ve
kterém bychom mohli psét a upravovat zdrojové texty.

Skript mizeme vytvofit nékolika zpusoby, bud'to pro konkrétni objekt nebo jako jeden z assets,
podobné jako tfeba materidl, ktery ndsledné pfetihneme/navésime na ty objekty, na které budeme
chtit.

Pro zacatek si vybereme prvni zpusob — vytvofit skript jako komponentu pro konkrétni objekt:
vybereme si hrdinu, zvolime Add Component a do vyhleddvaciho pole nahote

adiL a.c

=1 ( N
a (&l E
1a:

Component

Rendering

I Scripts

s Audio >
B Effects >
W Event 5 napiSeme ndzev skriptu Pohyb. Na to zmizi nabidka a objevi se
‘ol Layout > tlacitko New script, které stiskneme:
lof  Mesh >
M Miscellaneous > , — -
1 Navigation > Ragil L5
@ Physics 2D ¥ I (G ponydl 0} E
—  Physics > 2 Search
Flayables >| pri
N An
>

Na to nésleduje podobny dialog, kde jesté mizeme zménit jméno a potom skript vytvofit a pfipojit:

L 05
C, Pohyb L)

|

< New script

Name

R N ]

Nové vytvofeny skript se objevi i v panelu Assets:

1fi ‘ Assets

:  mgEd -

Scenes MBudka MHrdina MRovina Pohyb

I[ Create and Add ].
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a kdyz ho vybereme, v Inspektoru uvidime néhled kédu (a protoze tento skript je kratky, tak ho
vidime cely):

Assembly Information
Filename Assembly-CSharp.dll

using System. Collections;

using System.Collections.Generic;

using UnityEngine;

public class Pohyb : MonoBehaviour
// Start is called before the first frame update
void Start()

¥

/{ Update is called once per frame
void Update()
i

[}

Komentife vysvétluji, ze funkce Start() se vold na zatitku (to by se ndm hodilo pro pocatedni
vytvofeni bludi§té¢ a umisténi hrdiny a tyranosaura) a funkce Update() se vold jednou v kazdém
snimku vysledné hry — zde je tedy pfileZitost popsat chovini postavy, napiiklad jeji reakci na
klavesy.

Protoze ve vysledném projektu miizeme mit vice skriptd a mizZe ndm zileZet na tom, v jakém
vy proj P J
pofadi se budou prochdzet (naptiklad jestli se diive bude providét skript ovladajici hrdinu nebo

skript ovlddajici tyranosaura), mizeme si toto pofadi piedepsat kliknutim na tlacitko Execution
order...

[0 nspecior =
. Pohyb Import Settings £,
£

a nastavenim pofadi u téch skriptd, kde nds to zajima:

O Project Settings

.

Audio

Player (Changing the order of a script may modify the meta data for more than one script.)

Script Execution Order o,
Editor
IGHP““S 'Add scripts to the custom order and drag them to reorder.
nput
Php " Scripts in the custom order can execute before or after the default time and are executed from top to bottom. All other scripts execute at the default time in the 1
ysics arder they are loaded,
Physics 2D

Preset Manager

— UnityEngine. EventSystems EventSystem

~1000 | -
el TMPro. TextContainer 0 | -
T aEES — TMPro. TextMeshPro 105 | -
TextMesh Pro — TMPro. TextMeshProUGUL 100 | -
Time
VFX Default Time
[+-]
Apply
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Zatim nis to ale nezajima, tak nic nenastavujeme.

Takze zpitky, chceme pomoci sipek ovlddat pohyb hrdiny a mdme skript Pohyb a v ném funkci
Start(), kterd se zavold jednou na za¢itku a funkci Update(), kterd se bude volat v kazdém snimku.
Ladici vypisy

Pokud se chceme presvédcit, ze se obé funkce opravdu budou volat, mizeme do nich pfidat ladici
tisky. Na to si skript poklepanim na jeho ikonku otevieme ve Visual Studiu, na verzi pfili§ nesejde,
ted pravé pouziji volné dostupné Microsoft Visual Studio Community 2017:

;-g] TRex - Microsoft Visual Studio
File  Edit View Project Build Debug Team Tools Test Analyze Window Help

Pohyb.cs # X
[€¥] Assembly-CSharp ~ | #3 Pohyb

ions;

2 ions.Generic;

3 using UnityEngine;

4

5 —Jpublic class Pohyb : MonoBehaviour

6 {

7 // Start is called before the first frame update
8 = void Start()

9 {

1e

11 }

12

13 // Update is called once per frame
14 = void Update()

15

16

17 1

18 }

19

Ladici tisk vyvolame funkci Debug.Log(), kterou budeme volat jak ve funkci Start(), tak ve funk-
ci Update():

public class Pohyb : MonoBehaviour

{
// Start is called before the first frame update

void Start()

{
Debug.Log("START: " + this.name);

// Update is called once per frame
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void Update()
{

Debug.Log("UPDATE: " + this.name);

Pozndmka: Kdyz budu v textu zmirovat néjakou funkci, budu ji psit se zdavorkami (tieba Update()),
i kdyz to nemusi znamenat, Ze ta funkce nemd Zddné parametry.

Kromé slova ,START* nebo ,UPDATE" budeme tisknout jesté hodnotu vlastnosti name aktu-

dlniho objektu.

Aby se zmény projevily, nezapomeneme skript ulozit (neulozeny soubor pozndme podle hvézdic-
ky u jména souboru na zélozce textového editoru)

Pohyb.cs* + X

[£#] Assembly-CSharp
1 |
2
3 usir
4

a pak se midzeme vrétit do Unity (Visual Studio nechdme oteviené) a stisk-
neme tlacitko Play (tfeba kombinaci kldves Ctrl-P). Kdyz po chvili béh
nadi hry (jesté nic nedéld) zase ukoncime (tfeba stejnou kombinaci kldves),
piepneme se v okné projektu ze zilozky Project na zilozku Console

@1 Project | [l Console
I Create 'I

v | Favorites Assets
(O All Materials
QUAl ol |

a uvidime misto, kam se vypisuji ladici vypisy

@ Project El Console
| Clear || collapss | Clear on Play | Clear on Build | Ent

/1 START: Hrdina
3/ UnityEngine Debug: Log(Cbject)

71 UPDATE: Hrdina
2/ UnityEngine Debug: Log(Cbject)

/1 UPDATE: Hrdina
2/ UnityEngine Debug:Log(Qbject)

71 UPDATE: Hrdina
2/ UnityEngine Debug: Log(Qbject)

/1 UPDATE: Hrdina
2/ UnityEngine Debug:Log(Cbject)

/1 UPDATE: Hrdina

41



— 3 Pokratujeme

a vidime, ze zprava ,START* se vypsala jednou na za¢itku a potom opakované zprava ,UPDA-
TE®, podle toho, jak dlouho jsme nechali hru bézet. Také miiZeme vidét, Ze nds objekt se jmenuje

Hrdina.

Ladici tisky jsou cennym ndstrojem ve chvili, kdy néco nefunguje tak, jak m4, i kdyZ dnes uz mdme
i jiné ndstroje, moznd se k nim dostaneme.

FixedUpdate

Kdyz jsme u toho, tak mizeme také dodat, ze GameObject m4 jesté metodu FixedUpdate(), kte-
réd se vold pravidelné. Tato funkce slouzi k provadéni fyzikdlnich vypoctd, kde by nepravidelnost
vadila, a vold se pravidelné, zatimco &etnost volani funkce Update() mize byt vyssi nebo nizsi
podle slozitosti hry, vykreslovani apod. Pro bézné ucely budeme pouzivat funkci Update().

Vefejné proménné a Inspektor

Odbocka: Dobte, Unity v urcitych chvilich vola skript, ale ta vazba muzZe byt i opaénym smérem.
Cely skript popisuje jednu t¥idu, odvozenou od tfidy MonoBehaviour, pokud této tiidé pfiddime
néjakou vefejnou vlastnost, tfeba TextProUpdate, budeme ji moci vidét a nastavovat v Unity v okné
Inspektoru:

public class Pohyb : MonoBehaviour

{
public string TextProUpdate;

// Update is called once per frame
void Update()

{
Debug.Log(TextProUpdate+":" + this.name);

v = ¥ Pohyb (Script) (TR
Q

Script Pohyb
Text Pro Update

s Nafailt-Matarial Bl 2

KdyZ tam potom vyplnime hodnotu, tfeba ,BéZim!“, nemusime nijak ménit skript a pfitom béZici
y’ p vyp ) ptap

program bude VypiSOVﬁtZ
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(3 Project [El console

|C\=ar | | Collapse iCIear on Play |Clear on Build | |
), START: Sphere

“/ UnityEngine Debug: Log(Qbject)
Bézim!:Sphere

UnityEngine Debug: Log(Object)
Bézim!:Sphere

UnityEngine Debug: Log(Object)
Bézim!:Sphere

UnityEngine Debug: Log{Object)

5 £

r,

) £

/

Bézim!:Sphere
UnityEngine.Debug: Log({Object)

. Beézim!:sSphere

=
Y,

Mimochodem, asi uz jste si vimli tladitek, kterd dovoluji vymazat obsah okna Console (Clear)
nebo nastavit, Ze se md vymazat pii kazdém spusténi (Clear on Play).

Takze jesté neumime nasim objektem pohybovat, ale uZ umime propojit objekt se skriptem.

3.5 Pohyb

Kdyz chceme pohybovat hernim objektem, at uz na zacitku nebo v pribéhu hry, pouzijeme
k tomu jeho komponenty.

Komponenty objektu a skript

Pokud ze skriptu potfebujeme piistup k néjaké komponenté objektu, ziskime ho (generickou)
funkci GetComponent<>(), napiiklad

Rigidbody rb = GetComponent<Rigidbody>();
Komponentu Transform ale mame pfistupnou piimo, takze kdyz do skriptu pfidime vypis
Debug.Log(transform.position);

vypiSe do ladiciho okna soucasnou polohu objektu:

3 Project El Console
|C\ear | | Collapse iclaar on Play |Clear on Build | E
1 START: Hrdina
= UnityEngine.Debug: Log(Object)
1 (0.0, 0.5, 0.0)
UnityEngine.Debug: Log(Object)
7 UPDATE: Hrdina
i Vi

B T T R
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Nis ale vice nez ¢teni hodnoty bude zajimat nastavovani, protoze bychom potfebovali do nasi hry

pfidat pohyb!
Vector3

Pozice objektu a dalsi hodnoty jsou typu Vector3 — trojrozmérny vektor se slozkami X, Y a Z, tak,
jak ho zndme z okna Inspektoru. Ukdzeme si postupné nékolik moznosti, co s nim délat.

Moznost 1: Pomoci stejnojmenného konstruktoru (programujeme v C#!) mizeme vytvofit novy
vektor a dosadit ho:

void Start()
{

transform.position = new Vector3(0, 3, 0);

}

Vysledek bude, Ze se na zacdtku objekt pfesune na nové soufadnice. V nové poloze zistane po
celou dobu, protoze nemé komponentu Physics.Rigidbody a tedy na néj nepusobi gravitace:

Mimochodem, méli bychom si posunout kameru, abychom méli lepsi vyhled — vybereme objekt
Main Camera, v tu chvili se objevi malé okénko s pohledem z kamery, abychom nemuseli pfepi-
nat — a nastavime mu posunuti Position.Y na 5 (posuneme kameru nahoru) a Rotation.X na 30
(nebude se divat rovné, ale dolf ve sméru 30°):
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Kdybychom chtéli, miizeme jesté posuvnikem Scale zménit velikost (zoom), ale nechme to byt.

Takze dokdzeme skriptem zménit polohu objektu, pokud ale chceme objektem pohybovat, potte-
bovali bychom jeho polohu ménit opakované a tedy v metodé Update().

Moznost 2: Druhd moznost tedy bude opakované ménit hodnotu transform.position.

void Update()
{

transform.position += new Vector3(0.1f, 0, 0);

Pro typ Vector3 jsou pfetizené operdtory s¢itdni, pficitini a dalsi, takZe nemusime ménit polohu
po slozkich a mizeme psit intuitivni kéd, véetné operdtoru pficitini +=. Ta hodnota 0.1f, tedy
jedna desetina jako typ float je vysledek experimentq, ale stejné to neni dobfe, protoze nevime,
jak Casto se bude metoda Update() volat a dokonce to ani nemusi byt pravidelné, takze kdyz hra
zabloudi do néjaké slozitéjsi situace, Update se bude volat méné Casto a pohyb se zpomali. To neni

dobre.

Moznost 3: Tteti moznost je zeptat se, kolik ¢asu uplynulo od posledniho volini funkce Update()
a posouvat podle toho:

void Update()
{

transform.position += Time.deltaTime * new Vector3(0.1f, 0, 0);

Hodnota Time.deltaTime je v sekundéch, takze ted by velikost vektoru méla odpovidat tomu,
o kolik se ma objekt posunout za sekundu.

Moznost 4: Moznd uz také n&jaky Cas sledujete, jak se v kazdém voldni funkce Update() vytvaii
novy objekt typu Vector3 a fikite si, Ze je zbyte¢né takhle zatéZovat spravce paméti. Mohli by-
chom si vektor pohybu vytvofit jen jednou a pamatovat si ho, ale také mizZeme pouzit pfipravené
vektory ve tiidé Vector3:

void Update()

{
Debug.Log("UPDATE: " + this.name);
//transform.position += Time.deltaTime * new Vector3(0.1f, 0, 0);

transform.position += Time.deltaTime * Vector3.right;
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Kromé right tfida Vector3 obsahuje vektory pro dalsich pét smért.

Moznost 5: ...pfijde az za chvili, aZ se nau¢ime néco o ovladdni.
Ovladani

KdyZz umime objektem pohybovat, hodilo by se pohybovat s nim tam, kam chce uzivatel. Na to
mame nékolik funkci a moZnosti.

Funkce Input.GetKey() fik4, jestli je stisknutd kldvesa, na kterou se ptame. Takze kdyz funkce
Update() pouzije funkci Input.GetKey()

void Update()
{
if (Input.GetKey("right"))
transform.position += Time.deltaTime * Vector3.right;
if (Input.GetKey("left"))
transform.position += Time.deltaTime * Vector3.left;

muZeme objektem pohybovat pomoci Sipek.

Kdyby nds napadlo pohybovat se ve smérech up a down, tak to jde také, ale pozor, u Vektoru3
hodnota up znamend opravdu nahoru a down opravdu dolu:

a pro pohyb ,k sobé&“ a ,0d sebe“ (ve sméru osy Z) slouzi hodnoty a sméry forward a back:

void Update()
{
if (Input.GetKey("right"))
transform.position += Time.deltaTime * Vector3.right;
if (Input.GetKey("left"))
transform.position += Time.deltaTime * Vector3.left;
if (Input.GetKey("up"))
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transform.position += Time.deltaTime * Vector3.forward;
if (Input.GetKey("down"))
transform.position += Time.deltaTime * Vector3.back;

Relativni pohyb

Ted pfichdzi ta vySe zminénd pitd moznost pohybu:

Moznost 5: Pokud budeme chtit chodit s hrdinou v bludisti, je trochu nezvyklé, aby Sipka nahoru
znamenala vzdycky pohyb na sever, sipka doleva pohyb na zipad a podobné, spis je obvyklé, Ze Sipkou
nahoru se hrdina pohybuje kupfedu, ve sméru svého pohledu a $ipkami doleva a doprava se otaci.

Potiebujeme tedy Sipkou nahoru ménit pozici podle aktudlniho pootoceni a Sipkami do stran se

pooticet (SPEED je néjaka hodnota typu float):

void Update()

{
if (Input.GetKey("right"))
//transform.position += Time.deltaTime * Vector3.right;
transform.Rotate (0, 90f, 0);
if (Input.GetKey("left"))
transform.Rotate (0, -90f, 0);
if (Input.GetKey("up"))
transform.position += SPEED * gameObject.transform.forward;
}

Kdyz tento kéd spustime, zjistime jednak, Ze jsme si kouli uréujici smér otoceni hrdiny umistili
$patné a jednak Ze mame problém, protoze pii jednom stisknuti Sipky doleva nebo doprava se
odehraje vice volani funkce Update() a je t&€zké se otocit pravé o 90 stuprid.
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Prvni problém vyfesime tak, Ze kouli pfemistime:

¥ |Sphere [] Static =

Tag | Untagged 4| Layer | Default 4

¥ A Transform [VIEE:S
Position x[o  |v¥[os |Z[os |
Rotation x o Vo 1Zzlo 1

a druhy tak, Ze misto funkce Input.GetKey() pouzijeme funkci Input.GetKeyDown(), kterd se
ligf tim, Ze pro kazdé zméacknuti klavesy vraci True jenom jednou:

void Update()

{
if (Input.GetKeyDown("right"))
transform.Rotate (0, 90f, 0);

if (Input.GetKeyDown("left"))
transform.Rotate (0, -90f, 0);

if (Input.GetKeyDown("up"))
transform.position += SPEED * gameObject.transform.forward;

Pohyb s fyzikou neboli PouZij silu!

Moznost 6: Uvedeny piiklad méni polohu hrdiny po skocich a to je to, co potfebujeme, kdyz
chceme napodobit starou hru. Na druhou stranu, kdyZ mame k dispozici fyziku, nemusime sami
posouvat objektem, ale staéi mu nastavit rychlost nebo jesté lépe zapusobit na néj silou.

Protoze to, co mame ted, budu chtit dil pouzit, tak jenom pfiddme ptikaz do metody Start()
a nakonec ho zase vymazeme.

Protoze fyzika pusobi na komponentu Rigidbody daného objektu, vyrobime si pro ni proménnou
a zapusobime na ni silou — bud'to opét ve tvaru trojrozmérného vektoru nebo zaddnim slozek sily
ve smérux,y a z:

void Start()

{
Rigidbody rb = GetComponent<Rigidbody>();
rb.AddForce(-500, 0, 0);
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Pokud se nic nedgje, je dobré se podivat do okna konzole a mozna tam najdeme zpravu, Ze dotycny
objekt zddnou komponentu Rigidbody nema, v tom pfipadé mu ji pfiddme:

...a miZeme pozorovat, Ze ,nakopnutd® kostka se odkuli.

Jak velkd ma byt sila, zilezi na hmotnosti krychle a koeficientu tfeni krychle i podlozky, ale takto
s objekty ve hfe zatim pohybovat nebudeme, §lo mi jen o ilustraci toho, jak miZeme sahat na
komponenty objektu a tim jej pfimét k pohybu.

Umime tedy

Umime tedy pfipojit k objektu skript, vyuzit jeho metodu Start() i Update(), zjistovat, jestli je
nebo byla pravé ted’ stisknutd klavesa, ¢ist a ménit pozici a orientaci objektu. Dost na to, abychom
mohli zadit programovat hru.
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4 Hra
4.1 Prefab

Pokud chceme naprogramovat néco jako zminéné bludisté s tyranosaurem, potfebujeme pfidat

néjaké zdi nebo piekdzky, jinak by to bloudéni bylo snadné.

Prekazky bychom mohli vytvofit tfeba z krychli nebo jen samotnych zdi (zistaneme u krychli), ale
pokud bychom je prosté vytvofili a rozmistili ve scéné pomoci editoru, bylo by to jednak pracné
a jednak by to bludisté vypadalo pokazdé stejné. Budeme je tedy vytvéfet a rozmistovat pomoci
skriptu a na to se ndm hodi néco, ¢emu se v Unity fika prefab (¢esky ndzev nezndm a ani bych ho
nehledal, zistarime u nédzvu ,prefab®).

Prefab slouzi jako vzor, podle kterého miizeme pomoci skriptd vytvéfet instance. Vyhoda oproti
kopii je v tom, Ze pokud zménime prefab, zméni se viechny instance — a také v tom, jak uz zminé-
no, ze instance mizeme vyrabét skriptem, hodi se to tfeba na vytvéifeni stfel ve hrach, ve kterych
se stfili nebo ¢ehokoliv, co nebude ve scéné od zacitku.

Vytvoieni prefab-u

Prefab vytvofime tak, Ze né&jaky objekt pfetdhneme z okna Hierarchie do okna Project (nejlépe do
slozky Assets). Takze si ve scéné vytvorime krychli

= Hierarchy # Scene

Create ©
<t SampleScene
|/ Main Camera
| Directional Light
| IRovina

» _IHrdina

B Project
| create - |
v |/ Favorites Assets

Shaded

Set Active Scene

Save Scene
Save Scene As
Save All
Unload Scene
Remove Scene

Discard changes

Select Scene Asset
Add New Scene

Create Empty
2D Object
Effects

Light

Audio

Video

ul

Camera

Sphere
Capsule
Cylinder
Plane
Quad

Text - TextMeshPro
Ragdoll...
Terrain
Tree

Wind Zone
3D Text

0 Bl Materiale!
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Pokud ji nevidime, je to proto, Ze byla vytvofend na stejném misté jako nds objekt Hrdina:

— tak ji trochu posuneme:

Mohli bychom ji také trochu natdhnout do vysky, aby Hrdina nekoukal pfes zed — a posunuti
i zvétSeni vysky mizeme misto tahdni mysi udélat nastavenim vlastnosti Transform: posuneme
ji zménou Position. X, zvétsime zménou Scale.Y, ale protoze zvétdenim vysky se zed zanofi pod
povrch, vynofime ji zménou Position.Y:

W [Luue | LS ¥
Tag | Untagged 4] Layer | Default ™|
¥ . Transform

[P
Position X2 Y[I5_]z[o

Rotation X [0 Yo |z]o |
Scale X[1 Y3 |z [1 |
—_d - e . = =t s

#sScene | € Game  fAsset Store
Shaded zllzol] ® jsolatis

Jako posledni akci si novy prvek pojmenujeme (v okné Hierarchy, F2), zvolime jméno Zed (bez
hacka).
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Abychom ted objekt Zed zménili na prefab, chytime ho mysi v okné Hierarchy a pfetadhneme

mezi Assets:

| Assets
Is|

Scenes MBudka MHrdina MRavina Pohyb

V okné Hierarchy m4 ted Zed zménénou ikonku (to zdlezi na nastaveni Unity):

|create - a0
v € SampleScene* .=
_ Main Camera
|,/ Directional Light
JRovina
» GHrdina

i Zed >

A pokud bychom ted nasi hru spustili, uvidime jedinou instanci, kterou jsme ve scéné zanechali.

Instance prefabu

Pokud cheeme v editoru scény piidat do scény instance néjakého prefabu (vim, Ze to sklonovani
anglickych slov neni hezké), jednoduse je chytime v okné Assets a pretihneme:

3# Scene
Shaded

Zajimavéjsi ovsem bude vyroba instanci prefabu pomoci skriptu, proto tyto instance zase smazeme.

55



— 4 Hra

Budeme chtit, aby skript vyrabéjici zdi patfil k objektu Rovina, tak vybereme objekt Rovina, v In-
spektoru klikneme na Add Component a misto vybirdni z nabidky napiSeme do vyhledavaciho
pole nizev skriptu Rovina

Dynamic Qcclusion|y

vl g <, Roving () o
Con
Is| Search
coo TR
Mate [le
Mesk 1o
oo,
~ =

a klikneme na New script a pak jesté jenou na tlacitko Create and add.

Novy skript Rovina (soubor se jmenuje Rovina.cs, ale Unity ndzvy skriptd zobrazuje bez pfipony,
tak je budu psat také tak) otevieme poklepdnim a protoze instance objektd budeme chtit vytvaret
jenom jednou pfi spusténi hry, budeme ménit metodu Start().

Skript ale potfebuje odkaz na prefab, ze kterého chceme vytviret instance, proto ve skriptu vytvo-
fime vefejnou proménnou, ta bude tim pddem viditelnd v Inspektoru a tam vybereme piislusny
prefab, tedy postupné:
1) do skriptu pfidime vefejnou proménnou pro prefab:
public class Rovina : MonoBehaviour
{

public GameObject mujPrefab;

// Start is called before the first frame update

void Start()
{

...a nezapomene skript ulozit.

2) tato vefejnd proménnd bude viditelnd v okné Inspektoru (porad jesté mame vybrany objekt
Rovina),
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a u policka MujPrefab klikneme na ikonku napravo od hodnoty a ze zobrazené nabidky (pfep-
néte se na zalozku Assets)

NOITE

vybereme prefab Zed:

Samotné vytvofen{ instance potom obstard funkce Instantiate(), kterd mé jako parametry prefab,
pozici a otoceni. Kdyz uz tu funkci piSeme, tak si téch zdi vyrobime vice:

void Start()

{
for (int x = -4; x < +5; x++)
{
Instantiate(mujPrefab, new Vector3(x, 1.5f, 5), Quaternion.identity);
}
}

57



— 4 Hra

Soufadnice X nové vytvofenych objekti se méni od -4 do +4, soufadnice Y odpovida objektu sto-
jicimu na Roviné a soufadnice Z je nejvzdilenéjsi umisténi nad Rovinou. Pootoceni Quaternion.
identity uddva Zadné pootoceni:

Pozndmka: Pokud zkusime Sipkami pohnout nasim hrdinou proti zdi a pokud budeme vytrvali, Zjisti-
me, Ze umi prochazet zdi. Ukdzali jsme si nékolik moZnostt, jak pohybovat objektem a ta s nastavovdinim
polohy nent idedini v kombinaci s prekazkami a fyzikou.

4.2 Jak zmeénit prefab

Pokud zménime prefab, projevi se zména ve vSech instancich.

Abychom prefab mohli zménit, potiebujeme ho otevfit v rezimu prefabu (prefab mode). Pokud
néjakou instanci prefabu mame uvnitf scény, staci na ni v okné Hierarchie poklepat nebo kliknout

na §ipku napravo od instance.

Pokud Zéddnou instanci prefabu ve scéné nemame, mizZeme vybrat prefab v seznamu Assets a po-

tom v okné Inspektoru kliknout na tla¢itko Open Prefab

‘@ Inspector

[l Zed (Prefab Asset) &,

l Open Prefab J

{ O T —
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Nebo také mizeme v seznamu Assets na prefabu pravym tla¢itkem vyvolat lokdlni menu a vybrat

piikaz Open
I Create >
Show in Explorer I

Open
Delete

Rename

Copy Path Alt+Ctrl+C
Open Scene Additive

Import New Asset...

Import Package >
Export Package...

Find References In Scene

Select Dependencies

Refresh Ctrl+R
Reimport

=T

Reimport All

Extract From Prefab

Run APl Updater.
Update UlElements Schema
Open C# Project

Tak ¢i onak se ocitneme v rezimu, kdy miiZeme prefab upravovat, nastavovat mu vlastnosti, pfida-
vat komponenty a tfeba mu nastavit materidl pfetazenim materidlu MZed (pravé jsme si ho bez
vysvétlovini vyrobili) ze seznamu Assets na zobrazeny prefab:

H#scene | € Game i Asset Store .=
| Shaded NIRRT | 3 | m | Gizmos | @Al
€scenes | igzed o Auto Save

= It et B

Zpitky se vratime kliknutim na polozku Scenes v zdhlavi editoru nebo na $ipku doleva v okné
hierarchie:
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H scene

| shadzd ~||.28
scenes | hgzed

= Hierarchy

creater| Grar )
< \pzed

Pokud program spustime, véechny instance prefabu Zed maji nastaveny materidl MZed:

Dovedeme tedy vytvofit prefab, umime vytvéfet jeho instance a umime prefab i dodate¢né zménit
tak, Ze se zména projevi ve vSech jeho instancich.

4.3 Pohyb kamery

Kdybychom chtéli naprogramovat néjaké bloudéni v bludisti (nase bludisté je zatim hodné jedno-
duché), potiebovali bychom, aby hra¢ nemél takhle celé bludisté jako na dlani, ale aby vidél jen to,
co vidi hrdina. Budeme potfebovat pohybovat kamerou.

Protoze budeme chtit pohybovat kamerou pokazdé¢, kdyz se pohne hra¢, budeme s ni hybat ve
skriptu Pohyb a protoze s ni budeme chtit hybat v kazdém kroku, bude to ve funkci Update().

Pohledy na hru

Ve hréch se pouzivd jak pohled prvni osoby, tedy o¢ima hrdiny, tak pohled tfeti osoby, kdy je vidét
i postava hrdiny. Pfi pohledu prvni osoby stoji kamera na misté hrdiny a tedy hrdina neni vidét
(a takového mdme krdsného hrdinu!), pfi pohledu tfeti osoby stoji kousek za hrdinou, aby kromé
samotného pohledu hrdiny byl vidét i hrdina samotny. Za¢néme pohledem prvni osoby, protoze
to bude o trochu jednodussi.
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Pohled prvni osoby

Skript Pohyb je pfifazen objektu Hrdina, md tedy pfistup k vlastnostem tohoto objektu, ale po-
kud chceme, aby mohl manipulovat kamerou, musime mu ji pfedat jako parametr. Jak na to, to uz
jsme vidéli, pfiddme proménnou:

using System.Collections;
using System.Collections.Generic;
using UnityEngine;

public class Pohyb : MonoBehaviour
{

public Camera mojeKamera;

...av okné Inspektoru do ni pfetdhneme kameru — objekt Main Camera.

a

@ Main Camera Camer

Funkce Update() obsahuje testovani stisknutych klaves a podle toho tpravu polohy a orientace
hrdiny — to nechdme a jen na konec funkce pfidime dva fadky, které nastavi pozici a orientaci
kamery podle pozice a orientace hrdiny:

mojeKamera.transform.position = transform.position;
mojeKamera.transform.rotation = transform.rotation;

Kdyz hru spustime ted, najednou ji uvidime z pohledu hrdiny:
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Ta o3klivd véc nahofe je ta koule (,budka®), kterou jsme pfidali abychom vidéli orientaci hrdiny,
protoze kamera je umisténd ve stfedu hrdiny a divd se ven. MiZeme se ji zbavit tak, Ze ji odstra-
nime (i kdyz... hrdina neni vidét, ale je vidét jeho stin a to je docela pékné) nebo tak, Ze ji odskrt-
neme komponentu Mesh Renderer

v .| Cmesh Renderer 3
¥ Materials

Size (1 |

Elerment O |@MBudka le
¥ Lighting

Cast Shadows [ on o

Receive Shadows [V

, ale to také zmizi stin nebo ji posuneme tak, aby se dostala mimo pohled kamery (a tim se zdroveri
mohou vyfesit problémy s jejim nardZenim do okoli):

© Inspector
¥ Sphere | [ Static =
- Tag [ Untagged =] Layer [Defau\t é]
¥ ... Transform o
Position X [0 y[os  |z[025 |
Rotation X |0 | [0 |Z]0 |
Scale x[os  |v[os  z[o5 |
Ted uz pfichdzi chvile na to, abychom si pfipravili trochu slozitéjsi scénu, protoze ji vyrdbime
b )

skriptem (skriptem Rovina), tak to bude jen zména zdrojového kédu:

void Start()

{
for (int x = -5; x <= +5; x++)
{
for (int z = -5; z <= +5; z++)
{
Debug.Log($"{x}:{z}");
if ((x%2==0)8&&(2%2==0))
Instantiate(mujPrefab, new Vector3(x, 1.5f, z), Quaternion.identity);
}
}
}

...a vysledny pohled vypada takto:
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V bludisti s tyranosaurem byla vidét i horni ¢ast zdi, na to mizZeme budto zvednout kameru
vzhiru nebo zmensit vysku zdi. Zmensit vysku zdi mizeme budto zménou prefabu nebo tim,
Ze nové vytvofenym instancim nastavime vlastnost transform.localScale. Ale kdyz budeme
vyslednym instancim zmensovat vysku, musime také zménit jejich umisténi, aby se nevzndsely

ve vzduchu.
Vysledna funkce potom bude vypadat takto:

void Start()
{
for (int x = -5; x <= +5; x++)
{
for (int z = -5; z <= +5; z++)
{
if ((x %2 ==20) & (z % 2 == 0))
Instantiate(mujPrefab, new Vector3(x, 1, z), Quaternion.identity)
.transform.localScale = new Vector3(1l, 2, 1);

Vychozi pozice hrdiny je ale (0, 1, 0), to znamen, ze stoji v fadé zdi, pfidejme tedy do funkce
Start() jeste piikaz, ktery ho posune na kiizovatku:
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(& BY S [ [F1% | % ) [=center | @Local ]

To uz ptipomind pivodni hru (zkuste si s hrdinou Sipkami pohnout).
Pohled tieti osoby

U pohledu tfeti osoby mdme nékolik moznosti. Prvni z nich by byla prosté kameru pfipojit k ob-
jektu hrdiny, pokud se ndm to nelibi (nelibi), mizeme to udélat skriptem a oproti pohledu prvni
osoby potfebujeme jen kamerou trochu couvnout (od pozice odecist smér pohledu, pfipadné pro-
ndsobeny néjakym ¢islem) a kdyz ndm bude vadit, Ze z celé hry vidime jen zdda hrdiny, tak kameru
jesté trochu zvednout:

//mojeKamera.transform.position = transform.position;
//mojeKamera.transform.rotation = transform.rotation;

mojeKamera.transform.position += transform.up;
mojeKamera.transform.position -= 3*transform.forward;

Nevyhoda takového pohledu tfeti osoby je v tom, Ze nékdy prosté ,tii kroky za hrdinou“ neni to
spravné misto pro kameru — tfeba proto, Ze je tam zed.

Jind moznost, jak fesit pohled tieti osoby, je mit kameru na pevném misté, kterd bude jen ménit
orientaci tak, aby byl hrdina v centru zdbéru. To ale zase neni pfilis sikovné v bludisti, kde takto
hrdinu nejspi§ neuvidime. Dal§i moznosti maji zase dal§i problémy, takze zistaneme u pohledu
prvni osoby.
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4.4 Znovu pohyb hrdiny

Navrh

Vidéli jsme, Ze mame nékolik zpisobu, jak pohybovat postavou hrdiny — zménit polohu skokem
pii stisknuti kldvesy, ménit polohu postupné, pokud je stisknutd klivesa, nebo nastavit rychlost,
piipadné zapusobit silou a nechat pohyb na simulaci fyziky obsazené v Unity. Podobné spektrum
moznosti mame, pokud jde o otdceni. Problém je ale v tom, Ze kdyZ se md hrdina pohybovat v blu-
disti nad pravouhlou étvereckovou siti, potfebuje se oticet o devadesit stuprii a posunovat se tak,
aby skon¢il na spravném misté, protoze jinak se mu nepodaii zahybat do vedlejsich chodeb, budto
proto, Ze nemd spravny smér nebo proto, Ze nestoji pfimo proti odbocujici chodbé.

Mohli bychom to trochu osidit tim, Ze hrdinu zmensime a také tim, Ze zménime jeho tvar z krych-
le na vélec nebo kouli, protoze krychle se v chodbé $patné otdci, mohli bychom i trochu podvadét
a pozici i orientaci v pfipadé potfeby dorovnat na stfedy kostek a sméry rovnobézné s osami... je
to, jak to nékdy v programovini byvd — miZeme naprogramovat, co budeme chtit, ale potfebujeme
si rozmyslet, co tedy budeme chtit.

Zkusme proto ted (a to nezédlezi na Unity) navrhnout, jak by mélo fungovat ovladdni hrdiny, aby
to bylo hezké a pfijemné pro hrace.

Chteli bychom aby pohyb i oti¢eni probihaly postupné a ne skokem, aby to vypadalo hezky.
Zaroven bychom potfebovali, aby pohyb i otd¢eni koncily na téch spravnych mistech a Ghlech.
Proto navrhujeme toto:

Otoceni:

Po stisku otdceci kldvesy se hrdina zacne plynule (aby to bylo hezké na pohled) oticet a otdceni
skonéi, az bude otoceny jednim ze ¢tyf sméri rovnobéznych s osami X a Z (aby byl spravné oto-
Ceny pro dalsi pohyb).

Pohyb:

Po stisku kldvesy pohybu se hrdina zacne pohybovat vpfed, pohyb skon¢i, az bude stit na dalsi
pozici (ve stfedu &tverce).

Mime ndvrh, miizeme ho naprogramovat a zkusit, jak se ndm to jako hri¢im bude libit.

Pokud se vim nelibi, navrhnéte si vlastni pravidla ovlidani.
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Naprogramovat

Neékolik pozndmek k tomu, jak navrZzend pravidla naprogramovat.
Pohyb

Kdyz hra¢ stiskne kldvesu pro pohyb, zahdjime pohyb. Protoze reagujeme na stisknuti a ne na
drzeni, budeme si nékde pamatovat, Ze probihd pohyb — a pokud probihd pohyb, budeme se po-
souvat o dil odpovidajici uplynulému ¢asu Time.deltaTime.

To pamatovéini — mohli bychom mit proménnou, kterd fika, zda pravé ted probihd pohyb, nebo,
protoze néco podobného budeme potiebovat i pro oticeni, bychom mohli mit jedinou promén-
nou, udévajici, co pravé délime. Protoze za¢indme pohybem a nechceme to zatim komplikovat,
zistaneme u proménné pro pohyb. A protoze potfebujeme, aby drzela informaci mezi riznymi
voldnimi funkce Update(), nebude deklarovana uvnit této funkce, ale bude to ¢lenskd proménnd

tidy:
bool probihaPohyb = false;

Kdyz probiha pohyb, posuneme hrdinu o patfi¢ny dil cesty v patficném sméru, ale potfebujeme
u toho hlidat, jestli v tomto kroku nepfekroci cilové policko. To bychom dokazali s trochou poci-
tini a také feSeni pro Ctyfi rizné sméry, ale mizZeme si pomoci trikem: kdyz se pohyb bude roz-
bihat, tak si spocitime a ulozime cilové soufadnice (to je snadné, doted jsme se na né presouvali
skokem) a zapamatujeme si, za jak dlouho na né dojedeme. A béhem jednotlivych krokd misto
toho, abychom kontrolovali soufadnice nebo uhel, budeme kontrolovat jenom to, zda uz ubéhl
celkovy ¢as. Vtipné, ne?

Rychlost a rozméry

Kdyz pficitime k poloze hrdiny vektory jako transform.forward, pfic¢itime (nebo odecitime)
jednicku k dané soufadnici. Kdyz jsme vytvareli instance prefabu Zed, umistovali jsme je na celo-
&iselné souradnice. Kdyz se ptdime na uplynuly ¢as pomoci Time.deltaTime, dostavime hodnotu
v sekunddch. Takze pokud nastavime cilovou pozici na soucasnou pozici plus smér, posouvinim
po Time.deltaTime bychom tam dojeli za sekundu. Kdyz se budeme chtit pohybovat vyssi rych-
losti, budeme muset touto rychlosti ndsobit zménu soufadnice a délit zbyvajici ¢as. Udélame si
na to proménnou a pokud tato proménnd bude zase ¢lenskou proménnou objektu, dovoli nim to

v pribéhu hry ménit rychlost pohybu hrdiny:

float rychlostPohybu = 5;
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Otaceni
S otédcenim to bude podobné, cilovou orientaci si ulozime jako trojici thli
Vector3 cilovaOrientace;

a pozadovanou hodnotu ziskime tak, Ze soucasnou orientaci hrdiny pfevedeme na uhly a pfipo-
¢teme k nim nédsobek vektoru (0, 1, 0), tedy rotace podle svislé osy Y:

cilovaOrientace = transform.rotation.eulerAngles + smerOtaceni * Vector3.up;
Poradi

Musime jesté ohlidat spravné pofadi, ve kterém se ptime na jednotlivé podminky, tedy jestli
probihd pohyb, jestli probihd otdCeni — a teprve potom jestli je stisknutd néjaka klavesa. To nim
zamichd feSeni pohybu s feSenim otdceni, ale neni vyhnuti.

Zkusenost

Kdyz to vyzkousime, zjistime, Ze je trochu otravné pro kazdy krok znovu mackat kldvesu, tak
zménime voldni funkce Input.GetKeyDown() na volini funkce Input.GetKey().

A jesté jeden postieh — pokud v tomto kroku skonéi pohyb nebo otédceni, na nastartovani dalstho po-
hybu musime ¢ekat az do piistiho snimku, proto jesté zménime poradi. Hodilo by se nim v piipadé
nekonciciho pohybu nebo otaceni z funkce vyskocit piikazem return a jinak se ptit na stisknutou
klavesu, ale to bychom pfisli o pohyb kamery na konci funkce. Pfikaz skoku pouzivat nechceme, tak
si pomtiZzeme o8klivym trikem — cyklus, ze kterého budeme vyskakovat piikazem break:

bool probihaPohyb = false;
Vector3 cilovaPozice;

float zbyvajiciCas;

float rychlostPohybu 5;
bool probihaOtaceni = false;
float smerOtaceni;

Vector3 cilovaOrientace;

float rychlostOtaceni = 5;
void Update()

{

while (true)
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if (probihaPohyb)

{

zbyvajiciCas -= Time.deltaTime;
if (zbyvajiciCas <= 0)

{
transform.position = cilovaPozice;
probihaPohyb = false;
}
else
{
transform.position +=
Time.deltaTime * rychlostPohybu * transform.forward;
break;
}

if (probihaOtaceni)

{

zbyvajiciCas -= Time.deltaTime;
if (zbyvajiciCas <= 0)

{
transform.eulerAngles = cilovaOrientace;
probihaOtaceni = false;
}
else
{
transform.Rotate (0, Time.deltaTime * rychlostOtaceni * smerOtaceni,
break;
}

if (Input.GetKey("up"))

{

}

else

cilovaPozice = transform.position + transform.forward;
probihaPohyb = true;
zbyvajiciCas = 1f / rychlostPohybu;

if (Input.GetKey("left") || Input.GetKey("right"))

{

0);
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if (Input.GetKey("left"))
smerOtaceni = -90;
else

smerOtaceni 90;
cilovaOrientace = transform.rotation.eulerAngles + smerOtaceni * Vector3.
up;
probihaOtaceni = true;
zbyvajiciCas = 1f / rychlostOtaceni;
}

break;

mojeKamera.transform.position = transform.position;
mojeKamera.transform.rotation = transform.rotation;

Jde to naprogramovat jesté jinak

Naprogramovéni pohybu, jak jsme ho vidéli vyse, vychizelo z toho, ze celkovy pohyb (nebo
i otdeni, ale zistarime u pohybu) potfebujeme rozlozit mezi jednotlivéa voldni funkce Update().
V Unity ovSem mame jesté jednu moznost a to pouzit korutinu — podprogram, ktery bude pfe-
ruSovén voldnim yield return:

protected IEnumerator PlynulyPohyb(Vector3 konec)

{
float zbyvajiciVzdalenostsqr = (transform.position - konec).sqrMagnitude;
while (zbyvajiciVzdalenostsqr > float.Epsilon)
{
Vector3 novaPozice
= Vector3.MoveTowards(rb.position, konec, rychlostPohybu * Time.deltaTime);
rb.MovePosition(novaPozice);
zbyvajiciVzdalenostsqr = (transform.position - konec).sqrMagnitude;
yield return null;
}
}

Pohyb potom zahdjime voldnim

StartCoroutine(PlynulyPohyb(transform.position + transform.forward));
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Priklad tohoto pohybu mtzeme najit v Unity-tutoridlu 2D Roguelike (https://learn.unity.com/
project/2d-roguelike-tutorial).

Zména pozice a fyzika

Oba piedvedené postupy maji jednu nevyhodu, totizZ, Ze ménime pozici objektu a to jde $patné
dohromady s fyzikou. Kdyz totiz fyzika vi, Ze se blizi objekt, ktery md urcitou rychlost, miize za-
reagovat a objekt nepustit, pfipadné ho odrazit a podobné, podle nastaveni fyzikilniho materidlu.
Ale kdyz néjakému objektu fekneme ,,0d tedka budes stat tady!*, tak je pro fyziku tézké reagovat
a vysledky jsou nékdy nepifedvidatelné. Proto bychom zménu pozice méli pouzivat pouze tehdy,
kdyz jsme si zjistili, Ze na dané pozici nic neni — a to si ukdZeme pozdgji.

4.5 Tvar hrdiny

Uz jsme se zminovali o tom, Ze hrdina ve tvaru krychle mize mit problémy s oti¢enim v chodbich
bludisté a Ze by bylo sikovnéjsi, kdyby mél jiny tvar. I kdyZz ndm to ted nevadi, protoze se ota¢ime
pouze na kfizovatkach, ukazme si zménu tvaru hrdiny.

Prvni krok, ktery ale nestaci, je zménit tvar Hrdiny na vélec (3la by i koule):

¥ .| Cube (Mesh Filter o= 8
Mesh [ Cube ]
; : : ==

a také vymazeme jeho ¢ast — kouli, kterou jsme pouzivali pro oznaceni sméru — a jesté¢ Hrdinu
trochu zmensime:

¥ .| Sphere (Mesh Filter Q3
Mesh |8l Sphere o]

s Hrdina [ Static = 2
T Tag [ Untagged :] Layer | Default i
v A Transform @ = %
Position x[fo vy Jz[o ]
Rotation X [0 [ [0 |2 [0 |
Scale x[09  |v[1 =

Kdybychom se ted chtéli s Hrdinou oticet uprostied chodeb, tak to stdle nepiijde a pro¢, to uvi-
dime, kdyz si zobrazime pozménéného Hrdinu v editoru scény:
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Hrdina mi totiz pofad jesté komponentu Box Collider, ktera se stard o kolize s okolim — a kterd
md tvar hranolu! Box Collider tedy smazeme nebo jenom vypneme:

a pfidime Hrdinovi novou komponentu — Capsule Collider:

L IMviEs L Renuer er

¥ i [JBox collider

o

> Sigus | stansary
ql =

< Physics

I #Box Collider

a
Character Controller
\w* Character Joint

» Cloth

‘& Configurable Joint
& Constant Force
‘& Fixed Joint
“$Hinge Joint

|-/ Mesh Collider

A Rigidbody

) Sphere Collider

iSprlng Joint wvhn

Ted uz by se hrdina mohl otdcet i uprostfed chodeb, kdyby to potfeboval.

Neklopit!
A jesté jedna moznost, kterd by se nim mohla nékdy hodit: Kdybychom hrdinou (ve tvaru vy-

sokého vélce) nardzeli do jinych objektii, mohl by se ndm pfeklopit. Miizeme to zakdzat v jeho
vlastnostech:
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Ted uz ndm nespadne ani kdyby do né&j narazil Tyranosaurus Rex.

72



5 Bludiste a dalsi






— 5 Bludisté a dalsi

5 Bludisté a dalsi
5.1 Bludiste

Bludisté, ve kterém ma bloudit nd§ hrdina, je zatim trochu jednoduché. Tak se pojdme podivat na

Vytvofeni bludisté, i kdyz zatim hodné jednoduchého, fedi skript Rovina.cs, nechdme to v ném
i naddle. To, Ze bludisté je tvofeno instancemi prefabu Zed, nechdme také a zkusime se jen podivat

Velikost

Zatim jsme se moc nestarali o to jak jsou nase objekty veliké, nanejvys jsme je zvétSovali nebo
zmensSovali pomoci vlastnosti Transform.Scale, ale ted to budeme potiebovat védét. Nebo na-
opak, pokud budeme chtit vyrobit bludisté o daném rozméru, budeme muset patii¢né zvétsit nebo
zmens$it objekt Rovina, ktery tvoii jeho podlahu.

Z objektu Rovina se podivime na jeho komponentu typu Collider (Rovina mé ve skutecnosti
odvozeny typ Mesh Collider, ale to nim nevadi), ziskime ho funkci GetComponent():

Collider collider = GetComponent<Collider>();
Kdyz mdme collider, miZeme zjistit jeho velikost pomoci jeho vlastnosti bounds.size, ale na
vyslednou velikost ma jesté vliv nastavené skdlovéni, takze kdyZz chceme znét skutecnou velikost
Roviny (zatim jsme ji nijak neménili), spo&itdme ji jako
Debug.Log($"velikost: {Vector3.Scale(transform.localScale, collider.bounds.size)}");

(tu funkci transform.Scale() pouzivime k tomu, abychom nemuseli velikosti v jednotlivych osich
ndsobit kazdou zvl4st):

Debug.Log($"bounds.size: {collider.bounds.size}");
Debug.Log($"scale: {transform.localScale}");

Debug.Log($"vyslednd velikost:
+$"{Vector3.Scale(transform.localScale, collider.bounds.size)}");

a vysledek je:

bounds.size: (10.0, 0.0, 10.0)
scale: (1.0, 1.0, 1.0)
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vysledna velikost: (10.0, 0.0, 10.0)

Rovina mié tedy vychozi velikost 10 krdt 10 a budeme ji skilovat podle velikosti pozadovaného
bludiste.

Kde vzit bludisté

Myslime tim otdzku ,jak se dozvédét, kde maji byt Zdi a kde volno® — a moznosti je vic. Mizeme ho
napiiklad mit pevné zadané v programu nebo ho miiZeme nacitat ze souboru (jak se z Unity dostat
k soubortim?) nebo ho miZzeme generovat ndhodné (a jak zafidit, aby bylo hezké a prichozi?).

Abychom oddélili tvorbu bludis§té od pfipravy scény, navrhneme si format, ve kterém budou blu-
di§té uchovivina a pfeddvina, a potom budeme moci mit zvlast jednak funkce, které budou blu-
diste vyrdbét a jednak ¢dst funkce Start(), kterd podle daného bludisté pfipravi scénu.

Tento formit pro representaci informace o bludisti by mohl byt dvourozmérné pole znakii (na zed’
nebo volno by stacila logickd hodnota, ale ¢asem moznd budeme mit v tomto poli vic informaci),
nebo jesté lépe pole textovych fetézcl (to mizeme také prochdzet dvéma indexy, ale bude lépe

vidét jeho obsah).

Metoda Start() bude toto pole zpracovévat, nastavi velikost roviny a umisti Zdi (a pozdéji moznd
jesté néco dalsiho):

const char ZED = ,X*;
void Start()
{
// ziskat bludiste:
string[] blud = Bludiste_A();

// zjistit rozmery:
int sx = blud[0].Length;
int sz = blud.Length;

// prizpusobit velikost Roviny:
transform.localScale = new Vector3(sx / 10, 1, sz / 10);

// nasazet Zdi:
for (int x = 0; x < sx; x++)

{

for (int z = 0; z < sz; z++)

{
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if (blud[z][x]== ZED)
Instantiate(mujPrefab, new Vector3(x, 1, z), Quaternion.identity)
.transform.localScale = new Vector3(1l, 2, 1);

}

return;

Funkce Bludiste_A() jenom vriti pfipravené pole textovych fetézcii:

string[] BLUDISTE_A =

{
"XOXOKKKKXX™
"X X",
"X XXXXXXX!,
"X X X",
"XOXXX XXX,
"X X X X",
"XooXo X X",
"XOXXXXX X",
"X X",
XXX

I

string[] Bludiste_A()

{
return BLUDISTE_A;
}
Pohled hrice vypadd takto — [PEEEERENE=== [

e — e |
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a bylo by to dobr¢, az na tu divnou podlahu!

Pokud chceme zjistit, v ¢em je problém, pomize nidm zakomentovat ve skriptu Pohyb.cs fadky,
kterymi posouvime kameru do pohledu hrace:

//mojeKamera.transform.position = transform.position;
//mojeKamera.transform.rotation = transform.rotation;

— a vidime, Ze objekt Rovina je chybné umistény. Jeho atribut transform.position totiz stejné
jako u jinych objekti udavé soufadnice stfedu a ne néjakého rohu. Do metody Start() proto ke
zméné velikosti podle velikosti bludi§té pfiddme jesté posun:

// prizpusobit velikost Roviny - a posunout ji:
transform.localScale = new Vector3(sx / 10, 1, sz / 10);
transform.position += new Vector3((sx-1) / 2f, 0, (sz-1) / 2f);
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— 5 Bludisté a dalsi

5.2 Pozice hrdiny

Mime tedy jednoduchy zpusob, jak popsat bludisté (zatim jesté nefesime jeho nacitini ani gene-
rovéni), ale uz asi vidime, Ze tam schdz{ informace o umisténi a sméru pohledu hrdiny.

Domluvme se, ze hrdina bude v poli bludité znizornén jednim ze znakd ~ > v <, podle toho,
kterym smérem se bude divat, upravme ukédzkovy popis BLUDISTE_A a jeho zpracovini ve
funkeci Start().

string[] BLUDISTE_A =

{
XXXXXXXXXX!"
"X <",
"X XXXXXXX",
"X X X",
"XOXXX XXX!",
"X X X X",
"X XX X",
"X XXXXX X",
"X X",
XXX XXXXXXX !

b

Skript Rovina bude potfebovat pfistup k objektu Hrdina, mohli bychom mu pro néj zase vyrobit
vefejnou proménnou a v okné Inspektoru do ni pfetihnout nebo vybrat objekt Hrdina, ale protoze
objekt Hrdina budeme potiebovat jenom jednou, mizeme si ho nechat vyhledat:

GameObject hrdina = GameObject.Find("Hrdina");

Moznosti, jak vyhledat objekt, je vice, zde jsme pouzili vyhledani podle jména (pozor pfi piejme-
novani!).

Protoze ted uz v bludisti potfebujeme rozpoznavat pét riznych znakt (jeden pro zed a Ctyfi pro
hrdinu), nahradime podminéné piikazy if ptikazem switch.

// nasazet Zdi a umistit a nasmerovat Hrdinu:
GameObject hrdina = GameObject.Find("Hrdina");
for (int x = 0; x < sx; Xx++)
{

for (int z = 0; z < sz; z++)

{
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5 Bludisté a dalsi

switch (blud[z][x])

{

case ZED:

Instantiate(mujPrefab, new Vector3(x, 1,
.transform.localScale = new Vector3(1l, 2, 1);

break;

case N
hrdina.transform.position = new Vector3(x, 1, z);
hrdina.transform.eulerAngles = 0*Vector3.up;
Debug.Log(""");
break;

case ,<‘:
hrdina.transform.position = new Vector3(x, 1, z);
hrdina.transform.eulerAngles = -90 * Vector3.up;
Debug.Log("");
break;

case ,>°
hrdina.transform.position = new Vector3(x, 1, z);
hrdina.transform.eulerAngles = 90 * Vector3.up;
break;

case ,v‘:
hrdina.transform.position = new Vector3(x, 1, z);
hrdina.transform.eulerAngles = 180 * Vector3.up;
break;

}

Pozndmka: Miize byt matoucs, Ze radky v popisu bludisté jsou indexoviny od nuly odshora k vyssim
hodnoty jsou ddle, tedy vyse. TukZe

indexiim nize, ale ve scéné je nultd soutadnice Z nejblize a vyssi

skutecné bludisté bude proti svému popisu vertikdlné preklopene.

Miizeme to vyfesit tieba zménou fadku
switch (blud[z][x])
na

switch (blud[sz-1-z][x])
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— 5 Bludisté a dalsi

Pozndmka: Pokud chceme nastavovat pozici a orientaci hrdiny ve skriptu Rovina, méli bychom zrusit
Jeho nastavovdni ve skriptu Pohyb.

5.3 Bludisté jako asset

Zatim jsme méli popis bludisté uloZeny ve zdrojovém kédu programu.

Kdybychom chtéli bludi§té nacitat ze souboru, potfebovali bychom védét, kam takovy soubor
umistit a jak se k nému dostat ze zdrojového kédu, ale aplikace v Unity nepracuje s oddélenymi

soubory, misto toho pouzivé jeden druh Asset- — TextAsset.

TextAsset ziskime tak, Ze soubor s pfiponou .txt, .xml a nékolik dalsich pfetdhneme do okna
Assets. Na to ho Unity zkonvertuje do svého interniho formdtu a zpfistupni ndm ho pro skripty.

Soubor s bludistém
Vytvofime si tedy nejdfive soubor BludisteB.txt:

XXXXXXXXXXXXXXXXXXXXXXXXXKXXXXXXXXXXK

A

XXXXXXXXXXXXXXXXXXXXX

X X
X XXXXXXXXX XXX XXXXXXXXX X
X X X X X X
X XXXXXXXXX X X XXXXXXXXX X
X X X X
X X X X
X X X X
X X
X X
X X

XXXXXXXXXXXXXXXXXXXXXXXXXKXXXXXXXXXXK

Ulozeny soubor ale nesta¢i pfetdhnout jen do okna Assets, potiebujeme si v ném vytvofit slozku
Resources:
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5 Bludisté a dalsi

(JHrdina

g Select Dependencies
‘ c;;“ | Refresh Ctri+R
v | Favorites Assets .

O Al Materials—— o eimeort
©1 All Models -_ Reimport All
©) All Prefabs
Extract From Prefab
Run APl Updater.
& Scenes Scenes MBudka
» G Packages Update UlElements Schema
Open C# Project
& Assets
—

Create
Show in Explorer
Open

Delete

Rename

Copy Path

Open Scene Additive

Import New Asset.
Import Package
Export Package..

Find References In Scene

Alt+Ctrl+C

a teprve do ni pfetdhnout soubor s bludistém:

Project | [
| Create "

v _;Favorites

Folder
C# Script
Shader
Testing
Playables

Assembly Definition

Assembly Definition Reference

TextMeshPro

Scene
Prefab Variant

Audio Mixer

Material

Lens Flare

Render Texture

Lightmap Parameters
Custom Render Texture
Sprite Atlas

Sprites

Animator Controller
Animation

Animator Override Controller
Avatar Mask

Timeline

Signal

Physic Material

Physics Material 2D

GUI Skin

Custom Font

Legacy
UlElements Editor Window
Brush

|ASSEtS » Resources

(O All Materials
(O All Models
(O All Prefabs

v [l Assets

& Scenes
» Gl Packages

BludisteB

Ve skriptu (skript Rovina, funkce Start()) se na né¢j potom mizeme odkazat takto:
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string(]

{

Bludist

TextAsset ta

char[] odd = {

string[] blu
return blud;

e_B(O)

= Resources.Load("BludisteB") as TextAsset;

Art, o \nt )
d = ta.text.Split(odd,

System.StringSplitOptions.RemoveEmptyEntries);
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Objekt TextAsset mé vlastnost text, na rozdéleni pouzijeme metodu Split() a pokud si nejsme
jisti, jak jsou oddéleny fadky (CRLF, CR, LF), pouzijeme na déleni oba oddélovace, ale parame-
trem RemoveEmptyEntries fekneme, Ze prazdné polozky (pfipadny text mezi CR a LF) se maji
vynechat. Slo by to celé zkratit do méné piikazi, ale slo mi o piehlednost.

Pokud zase zakomentujeme pohyb kamery a pfipadné si kameru ve funkeci Start() trochu posune-
me

mojeKamera.transform.position = new Vector3(15, 15, -20);

bude to vypadat takhle:

Window Help

Takze umime do projektu pfidavat externi soubory a z projektu k nim pfistupovat (i kdyz tam ve
skute¢nosti zddné oddélené soubory nebudou).

5.4 Jak generovat bludisté skriptem
To je zajimava tloha, obzvlast pokud mdme pozadavky na to, aby se dalo dojit odkudkoliv kam-
koliv, a je$té navic tfeba na to, jak maji byt Siroké chodby — a nesouvisi to s Unity, tak to fesit

nebudeme.

Kdybychom chtéli jen ndhodné bludisté bez dalsich pozadavkay, tak potfebujeme jen umistit zdi
kolem dokola a ndhodné vygenerovat pozice zdi a pak néjaké umisténi a orientaci hrdiny, tfeba

takhle:
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— 5 Bludisté a dalsi

string[] Bludiste_N()

{
int sx = Random.Range (15, 50);
int sz = Random.Range (15, 50);
string[] blud = new string[sz];

float hustota = 0.20f;
bool uzBylHrdina = false;

for (int z = 0; z < sz; z++)
{
blud([z] = "";
for (int x = 0; x < sx; Xx++)
{
if ((x == 0) || (x == sx-1) || (z == 0) || (z == sz-1)
|| (Random.value < hustota))
blud[z] += ZED;
else
if (uzBylHrdina == false)
{
blud[z] += """;
uzBylHrdina = true;
}
else
blud[z] += " ";

}

return blud;

...ale neni na tom nic zajimavého.
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— 5 Bludisté a dalsi

5.5 Jesté jednou pohyb

Hrdina ndm chodi hezky, oti¢i se do pravého thlu a posouvd se na spravnd mista — ale zkusili jste
s nim narazit do zdi? Pokud ano, zjistili jste, Ze dokédze projit zdi!

Mohlo by nés napadnout, Ze je to proto, ze Zed (prefab) neméd komponentu Physics.Rigidbody.
Kdyz mu ji pfiddme, zjistime, Ze hrdina uz zdi projit nedokaze — ale kdyz do zdi narazi, tak se Zed
posune! Mohli bychom to fesit ,jako ve skutecnosti tak, Ze bychom v této komponenté nastavili
parametr Mass, tedy hmotnost, na néjakou velikou hodnotu. Anebo tak, a to pouzijeme, Ze zafi-

Xujeme orientaci i pozici:

¥ /. Rigidbody ["IEE

Mass 1
Drag 0
Angular Drag 0.05
Use Gravity

¥
Is Kinematic m
Interpolate
Collision Detection
¥ Constraints

Freeze Position WX Y M2

Freeze Rotation X Y M7
| > Info

Ted zed stoji pevnd jako skala — ale hrdina do ni zase znovu muze vejit! Musime to fesit jinak.

5.6 Vyslat paprsek

Funkei Physics.Raycast() mizeme vyslat paprsek z daného mista danym smérem do dané maxi-
mélni vzdalenosti — a zeptat se, jestli do nééeho narazil, pfipadné do ¢eho. A pokud pfed hrdinou
je néjakd prekazka, zatim se neptdme jakd, tak pohyb viibec nezahijit:

if (Input.GetKey("up"))

{
RaycastHit hitInfo;
if (!Physics.Raycast(transform.position, transform.forward, out hitInfo, 1f))

{
cilovaPozice = transform.position + transform.forward;
probihaPohyb = true;
zbyvajiciCas = 1f / rychlostPohybu;
}
else
Debug.Log("nejdu - prekazka");
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— 5 Bludisté a dalsi

Funkce Physics.Raycast ma mnoho riiznych zptsobu voldni a ten vystupni parametr hitInfo
bychom ted viibec nepotfebovali, ale bude se ndm hodit za chvili, tak si ho nechdme.

5.7 Sbér

Co kdyby nas hrdina mél v bludisti néco sbirat? At uz néjaké mince nebo puntiky, které potiebuje
vysbirat véechny jako Hungry Horace nebo Pacman, nebo néjaké bonusy, které mu budou posky-
tovat dalsi schopnosti?

Vyrobit je bude snadné, potiebujeme si jen v Unity vyrobit novy prefab, na to nejdiive pfiddime do
scény vilec (Cylinder),

waw - an
< SampleScene
|_IMain Camera

|| Directional Light

Set Active Scene

[_IRovina Save Scene
| IHrdina Save Scene As
Save Al
Unload Scene
Remove Scene
Discard changes
Select Scene Asset
Add New Scene
GameObject > Create Empty
3D Object > Cube
2D Object > Sphere
Effects > Capsule
Light > Cylinder
Audio > Plane
Video > Quad
ul > Text - TextMeshPro
Camera Ragdoll...
Terrain
Tree
Wind Zone

Project | El Conscle

reate *|
A rmmatima 2 oa

3D Text

pojmenujeme ho Mince, posuneme ho, abychom na néj vidéli (ale nakonec ho zase vratime na (0,
0, 0)), zménime mu velikost (pootoceni zménime teprve pii vytvafeni instance):

¥ Mince | ] Static =
Tag [ Untagged =] Layer | Default i

¥ . Transform ["IEE
-0.529

Position X 11,175 |¥ |1 =
Rotation X [90 |¥ o |z o |
Scale XlD.S |Y|D.DS |Z|D.5 |

vyrobime materidl MMince a nastavime mu Zlutou barvu, kovovy vzhled a hladkost:
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— 5 Bludisté a dalsi

. MMince o8
Shader | Standard =
Opaqus :

0.87

0.898

a pfetdhneme ho na objekt Mince:

Nakonec vynulujeme posunuti a objekt Mince pfetdhneme z okna Hierarchie do okna Assets,
¢imz z né&j vyrobime prefab:

Dale si potiebujeme vymyslet, jakym znakem budeme minci zndzorfiovat v popisu bludisté, tfeba
pismenem m — a upravit popis bludisté...

string[] BLUDISTE_M =
{
XXXXXXXXXX ™
"Xmmm <X",
"X XXXXXXX",
"X X X",
"XOXXX XXX",
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— 5 Bludisté a dalsi

"X XmmmX X",
"XX XmmmX",
"X XXXXXmX",
"X mmmmx" ,
XXXXXXXXXX "
}s

...a nakonec potiebujeme pii vytvafeni bludisté brit v potaz i znak m a na jeho misté vytvaret
instanci prefabu Mince podobné, jako vytvafime instanci prefabu Zed, kdyz vidime znak ZED

(taky bychom si na to ,m“ méli udélat proménnou):

case ZED:
Instantiate(PrefabZed, new Vector3(x, 1, z), Quaternion.identity)
.transform.localScale = new Vector3(1l, 2, 1);
break;
case "m":
Instantiate(PrefabMince, new Vector3(x, 1.2f, z), Quaternion.Euler (90, 45, 0));
break;

Parametr Quaternion.Euler(90, 45, 0) fik4, jak md byt instance pootocend. Z hlediska spravy pro-
gramu by bylo lepsi spravné pootoceny prefab Mince umistit do jiného prefabu, z néhoz bychom
potom vytvirfeli instance bez pootoeni, ale to ted fesit nebudeme.

Aby skript Rovina.cs mohl pouzivat prefab Mince, musime si na néj zase vytvofit vefejnou pro-
ménnou

public GameObject PrefabZed;
public GameObject PrefabMince;

(ptvodni proménou mujPrefab jsme pfejmenovali na vhodnéjsi PrefabZed) a v okné Inspektoru
skriptu Rovina nastavit prefab Mince jako hodnotu vlastnosti prefabMince:

~ Rovina Import Settings &, 2
-7 open... | [ Execution order...
Prefab Zed wZed @
Prefab Mince WwMince @

Vysledek potom vypadd takto:
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— 5 Bludisté a dalsi

Z dalsich minci v fadé jsou vidét jenom stiny.

Pozndmka: Nent iiplné snadné najit spravnou velikost a umisténi minci, pokud je dame prilis nizko,
neuvidime minci, kterou mdame pod nohama. Pokud ji dame prilis vysoko, nezaznamend ji nds prizkum

paprskem (funkei Raycast()) a kdyz do ni pri pohybu narazime, fyzika miize tvofit zajimavé efekty.

Co tedy ten slibeny sbér

Dobte, mdme v bludisti mince, vidime je, ale nemtizeme prochdzet, protoze pokud Hrdina paprs-
kem zjisti, Ze je pfed nim pfekdzka, nezalne se pohybovat. Zmifiovali jsme se o tom, Ze se miZzeme
zeptat, co je to za piekdzku — a ted na to pfiSel spravny Cas.

Vlastnost collider.gameObject vystupniho parametru funkce Raycast() vraci objekt, do kterého
paprsek narazil a tohoto objektu se pak miZeme zeptat na jméno (objekty, které vytvafime pfi
vytvafeni bludisté, se jmenuji Zed(Clone) nebo Mince(Clone), nebo lépe se mizeme zeptat na
obsah vlastnosti tag a do ni si poznamenat, co potfebujeme: Vybereme si prefab Zed, v Inspektoru
rozbalime nabidku Tag, pomoci Add tag do seznamu pfidime hodnotu zed a tu si pak vybereme:

e

¥ Zed | [ Static w
h Tag (zed i) Layer | Default ™|
vyA Tr Untagged
Fosition Respawn o
Rotatior Finish
Scale EditorOnly
m MainCamera
Mesh Player

v M GameController
v Matenal. zed

b Add Tag.
Eleme, =)
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A kdyz uz jsme u pfidavini znacek, rovnou si nadefinujeme i tag mince a uplné stejné ho pfidime

prefabu Mince:

QI0 | VBYNG | BTAls | LIZmos - |

| &% Tags & Layers I
] 40% 295 =

New Tag Name [mince] |
( Save ]

T T

Kdyz se ted v programu zeptime na vlastnost tag objektu, ktery byl zasazen paprskem, dostaneme
hodnotu zed a podle toho miiZeme upravit rozhodovani skriptu Pohyb pfi stisku klavesu kupfedu:

if (Input.GetKey("up"))
{
RaycastHit hitInfo;

if (Physics.Raycast(transform.position, transform.forward, out hitInfo,
1))

GameObject predeMnou = hitInfo.collider.gameObject;
if (predeMnou.tag=="zed")
{
Debug.Log("nejdu - prekazka");
break;
}

// else - mince => sbhirat...

// kdyz jsem dosel sem, tak JDU a uz se na nic neptam:
cilovaPozice = transform.position + transform.forward;
probihaPohyb = true;

zbyvajiciCas = 1f / rychlostPohybu;

Maime bludi$té, mdme v ném mince, umime je pfi pohybu odliit od zdi, zed ndm brani v pohy-
bu — a co mince? Zilezi na nadem rozhodnuti. Mohlo by to vypadat tfeba takhle:

Kdyz chceme jit kupfedu
(to chceme, jinak bychom nevysilali paprsek a nezkoumali, co je pfed ndmi)
a zjistime, Ze pfed nimi je Mince, tak fekneme té Minci, at se znici
(na to bude mit Mince néjakou funkei a bude to chvili trvat)
a az se Mince znidi, tak ohldsi Hrdinovi, Ze je zni¢eno
a Hrdina si pficte body a né&jak je zobrazi.
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Takze vyrobime skript Mince pro minci, tfeba prostfednictvim pfidani komponenty v okné In-
spektoru:

Height 2

Dir
Q. Mincel L)

Search

NTT=T

Volani funkce z ciziho skriptu

Abychom mohli zavolat funkci, kterd je definovana v jiném skriptu, potfebujeme nejdfive najit

ten skript:

if (predeMnou.tag == "mince")

{
Mince skriptMince = GameObject.FindObjectOfType(typeof(Mince)) as Mince;
skriptMince.Seber (predeMnou) ;
break;

Protoze tim najdeme skript a funkei, ale ten skript a tu funkci sdili vSechny mince, budeme jako
parametr pfedédvat, ktera mince se ma znicit.

Pozndmka: Moznosti, jak vyhleddvat objekt a jak popsat, co chceme hledat, je vic; casem uvidime dalsi.

Cely skript pro mince potom vypadd takto:

public class Mince : MonoBehaviour

{

float casDoKonceSbirani;

GameObject sbiranaMince;
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// Start is called before the first frame update
void Start()
{

casDoKonceSbhirani = 0f;

public void Seber (GameObject mince)
{
sbiranaMince = mince;

casDoKonceSbirani = 1f;

// Update is called once per frame
void Update()
{
if (casDoKonceSbirani > Q)
{
sbiranaMince.transform.eulerAngles += Time.deltaTime * 720 * Vector3.up;
casDoKonceSbhirani -= Time.deltaTime;
if (casDoKonceSbirani <= 0)
{

sbiranaMince.SetActive(false);

Pohyb skriptPohyb = GameObject.FindObjectOfType(typeof (Pohyb)) as Pohyb;
skriptPohyb.MinceSebrana();

Funkce Seber(GameObject mince) nastavi, kterd mince se ma sebrat a zbyvajici ¢as do konce.
Funkce Update() potom, pokud ¢as do konce jesté nevyprsel, otai (tou sbiranou) minci, zmensuje
zbyvajici ¢as a v okamziku, kdy Cas vyprsi, deaktivuje sbiranou minci a posle zpravu skriptu Pohyb
pomoci zavoldni funkce MinceSebrana().

5.8 Pocet sebranych mincia Ul

Ve skriptu Pohyb() si budeme pamatovat pocet sebranych minci, ale bylo by pékné, kdybychom to
mohli né&jak ukdzat uzivateli. K tomu slouzi prvky uzivatelského rozhrani neboli UL
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Pro vytvifeni uzivatelského rozhrani existuje v Unity nékolik knihoven, v soucasné dobé to jsou
UlElements, Unity Ul a IMGUI (ale pravdépodobné bude existovat i fada dalsich). Pro nasi hru
pouzijeme knihovnu Unity Ul

Unity Ul

Vsechny ovlddaci prvky musi byt uvniti objektu Canvas. Vytvofime ho v okné hierarchie, stejné
jako dalsi ovladaci prvky:

| Create 7| 1Al B |

v € SampleScene -=|
|_IMain Camera

|| Directional Light

Display 1 %] Free Aspect &
| Display 1l P

|_JRovina
[ Hrdina
Iy Mince
Text
Copy Text - TextMeshPro
Paste Image
Rename Raw Image
Duplicate Bution
Delete Button - TextMeshPro
Toggle
Select Children Slider
Select Prefab Root Scrollbar
Create Empty Dropdown
3D Object > Dropdown - TextMeshPro
2D Object > Input Field
-m Effects > Input Field - TextMeshPro
Clear | | Collapse | Clear on Play Light > Canvas
Audio > Panel
Video > Scroll View
ul > Event System

Camera

V editoru ani po pfepnuti na zdlozku Game nic neuvidime, ale v okné hierarchie miiZeme objekt
Canvas vybrat a v okné Inspektoru mu nastavovat vlastnosti. Vlastnost Render Mode urcuje, ja-
kym zptisobem se bude Canvas vykreslovat, ponechdme vychozi hodnotu Screen Space - Overlay
neboli bude se kreslit az na vysledny obrizek a v tom pfipadé nemusime fesit velikost, protoze

bude sahat od kraje do kraje:

Il
v |@canvas @
Render Mode [ Screen Space - Overlay #]
Fise ol FimeFe o 1

Pro vytvofeni textu pole mame (jako u ostatnich tkolit) vice moznosti.

Prvni moznost je vytvofit text jako novy objekt, druhd jako komponentu objektu Canvas.
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Text jako novy objekt

Objekt Text vytvoiime v okné hierarchie:

= Hierarchy

| create = | (Grall )

v € samplescene*

|_IMain Camera
|_IDirectional Light

_IRovina
| Hrdina
Iy Mince
() Canvas
(JEventSystem
Copy
Paste
Rename
Duplicate
Delete
Select Children
Select Prefab Root
Create Empty
@ Project [ 3D Object
| create ~ | 2D Object
v {}(&avnrites Effects
All Materials .
L All Models Light
(O All Prefabs Audio
Video
= Assets ul

## Scene
Shaded

Text

Text - TextMeshPro
Image

Raw Image

Button

Button - TextMeshPro
Toggle

Slider

Scrollbar

Dropdown

Dropdown - TextMeshPro
Input Field

Input Field - TextMeshPro
Canvas

Panel

Scroll View

Event System

SR e |

m@ SlCEI'VES |
a novy objekt se automaticky zafadi pod objekt Canvas
(pfedchozi krok jsme mohli pfeskocit, vytvofit rovnou
objekt Text a pokud by zadny objekt Canvas neexistoval,
vytvofil by se automaticky).

Text jako komponenta objektu Canvas

Druha moznost spoéivd v tom, Ze objekt Canvas vybere-
me (pokud neni vybrany), a v okné Inspektoru mu pfi-
ddme komponentu Text pomoci Add Component a Ul
a Text:

Dalsi pokracovani je podobné, i kdyz umisténi vysled-

ného textu mize byt pokazdé jiné. Budeme pokracovat
z druhé zminéné moznosti — tedy text jako komponenta.
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Do vlastnosti Text napiSeme text a miZeme u toho zménit i par dalsich vlastnosti jako je pismo,
zarovndni horizontdlni i vertikilni, barvy a podobné. Zménime tfeba velikost pisma a vertikdlni
zarovnani:

v | ¥ Text (Script) o %
Text
Zatim zadn€ sebrané mince

Character
Fon: °
Font Style

Line Spacn

Rich Text ¥
Paragraph

Algnment

Align By Geometry[ |

Horizontal Overfloy Wrap ¢]
Wertical Overflow
Best Fit m)
| cor E—
vt o
Raycast Target I~

Kdyz program spustime, vidime v levém dolnim rohu text:

Zatim zadné sebrané mince

Pocet sebranych minci
Kdyz skript Mince ohlési skriptu Pohyb, Ze byla sebrand mince, chceme zménit zobrazeny pocet
sebranych minci. K tomu potfebujeme proménnou, kterd bude obsahovat aktudlni pocet sebra-

nych minci a potfebujeme ménit text Ul komponenty Text.

Abychom se dostali k vlastnosti Text objektu Canvas, pfidime skriptu proménnou
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public Canvas mujCanvas;

a v editoru vybereme Hrdinu a do proménné skriptu Pohyb pfetihneme objekt Canvas:

¥ = ¥ Pohyb (Script &,
Script « Pohyb Q
Q

Q

(o]

|

Moje Kamera s Main Camera (Camers
Moje Svetlo - Directional Light (Lig
Muj Canvas [|Canvas (Canvas)

Ve funkci MinceSebrana() potom najdeme komponentu Text a zapiSeme do ni pocet sebranych

minci:

public void MinceSebrana()

{
pocetSebranychMinci++;
UnityEngine.UI.Text txt = mujCanvas.GetComponent<UnityEngine.UI.Text>();

txt.text = $"Pocet sebranych minci: {pocetSebranychMinci}";

Kdyz ted chodime bludi$tém a sbirime mince, program zobrazuje, kolik jsme jich uz sebrali:

Pocet sebranych minci: 9

Dalsi moznosti

Moznosti, jak vytvofit uzivatelské rozhrani, je vic. MozZnosti, jak udélat ten ¢i onen krok, je také
vic — berte to jako vzorek a experimentujte.
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5.9 Zvuky

Zvuky, stejné jako obrédzky, animace, materidly, skripty a dalsi patfi mezi Assets. Protoze si zvuky
chceme jenom vyzkouset a protoze pracujeme pod Windows, séhneme do adresife C:\Windows\
Media (jestli mate Windows instalované na jiném disku nebo v jiném adresafi, pouzijte odpo-
vidajici jinou cestu a pokud pouzivite jiny operalni systém, vyberte si jiny adresaf se zvukovymi
soubory), popadneme napiiklad soubor Alarm02.wav a pietdhneme ho do okna Assets:

@ Project  [NEICONSoIEN
| creste -
v | /Favorites \ Assets

O All Materials

i -7 -7 . a - .
(& Resources Resources Scenes Alarm02 MBudka MHrdina Minee
3 Scenes

O Al Prefabs
Soubor se zkonvertuje do objektu typu AudioClip a kdybychom chtéli, mizeme mu v okné In-
spektoru nastavit dalsi vlastnosti. Nechceme.

Abychom mohli zvuk pfehrét pfi sebrani mince, pfidime do skriptu Mince vefejnou proménnou
public AudioClip audioClip;

Potom v okné Assets vybereme prefab Mince (pozor, prefab! Ne stejnojmenny skript!):

C#

MHrdina Mince MMince

a v okné Inspektoru v komponenté Mince (Script) kliknutim na ikonku nebo pfetazenim z okna
Assets vyplnime proménnou AudioClip:

| ¥ | [¥Mince (Script) [WIEES
o

Script Mince

Audio Clip iAlarmoz2 o]

Pak uz stadi jen do funkce Seber(GameObject mince) piidat piehrini zvuku s uréenim mista,
odkud bude zvuk vychizet:

public void Seber (GameObject mince)

{

sbiranaMince = mince;
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casDoKonceSbirani = 1f;
AudioSource.PlayClipAtPoint(audioClip, transform.position);

5.10 Sestaveni

Nasi hru zatim zkousime tak, Ze klikneme na tla¢itko Play nebo pouzijeme klavesovou zkratku
Ctrl-P. Ale kdybychom ji chtéli dat nékomu, kdo nema Unity, potfebujeme ji sestavit (preklad
anglického Build).

V menu vybereme File a Build Settings:

File Edit Assets GameObject Compo
New Scene Ctrl+N
Open Scene Ctrl+O
Save Ctrl+S
Save As... Ctrl+Shift+S.
New Project...

Open Project...

Save Project

Build And Run Ctrl+B
Exit

v,

a vybereme si, na jaké platformé nase hra pobézi (pro nékteré platformy mize byt potfeba doin-
stalovat néjakou ¢ast Unity):

fac & Linux S
B WebGL

2 Universal Windows Platform

[ oo one
' Android

 Player Settings... |

R

98



— 5 Bludisté a dalsi

Protoze chceme verzi pro Windows, nic neménime a zvolime Build nebo Build And Run.

Nisleduje dialog pro vybér adreséfe, vytvofime novy a pojmenujeme ho vysledek:

3¢ Build PC, Mac & Linux Standalone

T <« Windows (C:) > DATA > PRJ_Unity Kniha > TRex2 v O Prohledat: TRex2 pel
Usporadat ~ Nova slozka =~
~

PRI_HIST ~ Nazev Datum zmény Typ
PR)_ISkres vs 19.07.2020 1559 Slozka soubor(
PR Karma Assets 02.08.2020 21:31 Slozka soubord
PRJ_Lab2020 Library 02.08.2020 21:42 SloZka souborfi
PRJ_Nette Logs 19.07.2020 15:33 Slozka soubord
PRJ_pole obj 19.07.2020 15:59 Slozka souborl
PRI_PY SVG Packages 19.07.2020 15:33 Slozka souborl
PRISLU ProjectSettings 02.08.2020 12:26 Slozka souborl

. Temp 02.08.2020 21:42 Slozka soubord
PRJ_Unity

vysledek 02.08.2020 21:43 Slozka soubord
PRJ_Unity_Kniha
TRex
TRex2
v o< >
Slozka: | vysledek
Vybrat slo Zrusit

Klikneme na Vybrat slozku a mtiZeme sledovat, jak probiha pfeklad, muzZe to trvat nékolik sekund.

Po skonceni vysledny adresdi obsahuje nékolik podadresdii a nékolik soubort — a spustitelny
soubor s ndzvem stejnym jako nidzev naseho projektu je nase hra:

Nazev Datum zmény Typ Velikost
MonoBleedingEdge 02.08.2020 21:46 Slozka soubor(
TRex2_Data 02.08.2020 21:46 SlozZka soubord
Q TRex2.exe 26.09.2019 3:44 Aplikace 625 kB
Q UnityCrashHandler32.exe 26.09.2019 3:39 Aplikace 1437 kB
D UnityPlayer.dll 26.08.2019 346 Roziifenr aplikace 18452 kB

5.11 Kde je tyranosaurus?

No, neni... nebo slovy jednoho starého vtipu — ,Pfece v Polsku!“ Tahle hra nim pomohla ukdzat
nékteré ndstroje a tyranosaura si nechdme na dalsi hru.
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6 Projekt Tyranosaurus

Projekt Tyranosaurus

6.1 Navrh

Pojdme vymyslet novou hru, a misto lepeni po kouskach zkusme nejdfive dopfedu rozmyslet, jak

bude vypadat:

bude na veliké plose

budou tam (ndhodné rozmisténé) piekazky

bude mit vice scén — tedy Ze se nesko¢i hned do hry, ale bude pfedtim néjakd tvodni scéna,
pak vlastni hra a na konci néjaké vysledky

bude tam hrdina

kamera se bude divat z pohledu prvni osoby, ale bude mozné se pomoci mysi divat do stran,
piipadné nahoru a dolu

bude tam tyranosaurus, moznd i vic tyranosauri

tyranosaurus nebude uplné hloupy a kdyz uvidi hrdinu, ptjde pfimo k nému (ale kdyz ho
neuvidi, nechd ho byt)

tyranosaurus se bude pohybovat rychleji nez hrdina, aby se pfed nim nedalo utéct

kdyz se tyranosaurus dotkne hrdiny, zpisobi mu poskozeni nebo ubere jeden z jeho Zivota
kdyz hrdinovi nebude zbyvat Zadny Zivot, hra kon¢i

hrdina bude moci tyranosaura na chvili zastavit, pokud bude mit patfi¢né kouzlo/efekt/zbrai
kouzla/efekty/zbrané budou na plose nihodné rozmisténé, moznd budou i pfibyvat a hrdina
je bude nachdzet a sbirat

kromé kouzel/efekti/zbrani bude hrdina sbirat i mince, aby mél néjakou motivaci se pohybovat

pohyb hrdiny bude fungovat pomoci pfidavéni sily a fyziky, takze Zadna policka a mfizka

Mime ndvrh, uvidime, jak to dopadne.

6.2 Novy projekt

Spustime Unity Hub, klikneme na NEW, piipadné vybereme verzi Unity (ted na tom nezilez,
vyhovi jakakoliv verze), vyplnime ndzev projektu a cestu, kde bude ulozen a potvrdime CREATE.

6.3 Scény

V okné Assets vidime oddéleni Scenes, kdyz se do né&j proklikime, vidime Ze obsahuje jedinou
scénu SampleScene:
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— 6 Projekt Tyranosaurus

I3 Project

Assets » Scenes

Smazeme ji a vytvoiime tfi nové scény, které pojmenujeme Uvod, Hra a Konec:

B Project

Assets > Scenes

Dvojitym kliknutim vybereme scénu Hra a ostatni scény nechdme na pozdéji. Kterd scéna je ak-
tivni, midZeme vidét v okné Hierarchie:

“= Hierarchy

6.4 Objekty ve scéné

Pro to, po ¢em budou nasi hrdinové chodit, mizeme pouzit budto Plane nebo Terrain. Terrain
dovede vice, jako tfeba editovat vysku, kopce a udoli, péstovat stromy a podobné a zfejmé je o néco
ndro¢néjsi na vykreslovani i detekei kolizi; pro nasi hru vysta¢ime s rovinou (Plane) pojmenova-
nou Rovina. A protoze chceme nasi hru vétsi, tak ji desetkrat zvétsime v ose X a v ose Z:

@ Inspector

¥ Rovina [ static =

Tag [ Untagged ¢ | Layer | Default -
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— 6 Projekt Tyranosaurus

Hrdina (pojmenujeme ho tak) bude reprezentovin zase vilcem (Cylinder), kterému upravime

vysku, aby nebyl tak vysoky a polohu, aby se nevzndsel nad zemi:

¥ Hrdina | [ Static =

M Tag | Untagged ¢ | Layer | Default ™|
¥ .. Transform RS
Position xo v[os z[o
Rotation X [0 ¥ [0 1z [0 |
Scale X [T I¥[es Jz[1 ]

Stejné jako v minulé hie vyrobime materidly MRovina a MHrdina, kterym zatim nastavime
jne j vy y ry
jenom barvu:

& collab -
B - | Gizmos -

A podobné jako v minulé hie vyrobime prefab Zed, ze kterého budeme vyrabét prekdzky a k nému
materidl MZed,

6 Inspector

I | Zed | [ static =

e Tag m‘d ¢ Layer | Defautt 1]
¥ . Transform K
Position x[z2 |v[os z[lz
Rotation X0 Yo 1z|o |
Scale X1 J¥ [t 1z [1 |
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pokud si uz nepamatujete, jak se vyrobi prefab, tak tim, Ze néjaky objekt z okna Hierarchie pfetdh-
neme mezi Assets, ale nejdfive se v okné Assets pfepneme ze seznamu scén zase do kofenového
adresafe (také bychom si mohli vyrobit slozku na prefaby, ale vzhledem k tomu, kolik jich budeme
mit (mdlo), bych to nefesil):

| e =

v | ;Favorites | Assets
O All Materials
(_lAH Models
QAH Frefabs -
E Scenes Scenes MHrdina MRavina MZed

Piedstavoval jsem si, Ze na zacitku Zdi tak néjak napadaji z vysky a tim vytvoii pfekazky, za ktery-
mi se budeme skryvat pfed tyranosaurem, ale kdyz zkusime tu instanci prefabu Zed, kterou méame
ve scéné, zvednout a spustit hru, nic se nedéje. Nepadd, protoze nema komponentu Rigidbody
a tedy na ni nepusobi gravitace. Tak ji pfidime —

y MOtIoN VeCtors | Per Object Mation ¢
D

Y]
I

u.‘
»

< Physics
BT I Box Callider a
watd | Capsule Collider
CentdeCharacter Controller
X ¥ Character Joint
Size () Cloth
o & Configurable Joint

& Constant Force
» |« Fixed Joint

“¢Hinge Jaint
|.:/Mesh Collider

LI

i

H
$

It

(W sphere Collider
Spring Joint v

—auz pada.

6.5 Assets - export a import

Casem budeme chtit pridat jesté objekt Mince, véetné materidlu MMince a to uz bychom se

méli ptat, jestli je opravdu potfeba v novém projektu stejné assets vytvifet znovu. Potieba to neni,
v okné Assets miizeme vybrat prvky, které chceme

\ Assets
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a v menu Assets potom fici, Ze je chceme vyexportovat:

Assets  GameObject Component Window Help

Create >

O

Show in Explorer
Open
Delete

Rename
Copy Path Alt+Ctrl+C

Open Scene Additive

Import New Asset...

Import Package >
Export Package...

Find References In Scene

Select Dependencies

Refresh Ctrl+R
Reimport

Reimport All

Extract From Prefab

Run APl Updater...

Update UlElements Schema
Open C# Project

av cilovém projektu zase ze stejného menu vybereme polozku Import Package. Ale tento projekt
chci vytvatet od zacatku, bez zévislosti, tak nic pfebirat nebudeme.

Minci vytvoiime podobné jako v minulém projektu — 3D Object — Cylinder, pfejmenujeme na
Mince, upravime rozméry

@ [nspector
¥ Mince | []Static
Tag | Untagged ¢ Layer | Default 4]
¥ A Transform o,
Paosition H |2 Y 0.05 zZ 2
Rotation X |0 Y0 Z0
Scale X |1 Y 0.1 Z1

a vyrobime zluty leskly materidl MMince

& Inspector

i MMince @,
Shader | Standard -]
Rendering Mode [ Opaque +]
Main Maps
 oAlbedo 2
 aMetalic e . [0.56 1
SMoothness  ee—(m—| 0. 398
Source | Metallic Alpha +]

aNormal Map
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a pfetdhneme ho na Minci:

(Tady jsme si pootocili pohled na scénu, abychom se divali proti svétlu a bylo vidét, jak se Mince
leskne.)

Nakonec objekt Mince pietéhneme z okna Hierarchie do okna Assets a tim z néj vyrobime

prefab:

| Assets

.

Scenes MHrdina

MMince MRovina MZed Zed

6.6 Skripty

Potiebujeme jeden skript, ktery by pohyboval Hrdinou a také pohyboval kamerou, kdyz se hybe
Hrdina, a nakonec otdcel kamerou, kdyZ budeme hybat mysi. A druhy skript, ktery na zacitku
zanefddi Rovinu instancemi prefabu Zed. Tak pojdme do toho!

Hrdina
Skript pro pohyb Hrdiny tentokrit pojmenujeme Hrdina, stejné jako objekt, ke kterému bude pa-

tfit. Vyrobime ho tieba tak, Ze vybereme Hrdinu ve scéné a v okné Inspektoru mu pfiddime kom-
ponentu, nevybirime z nabidky, ale napiSeme jméno a potvrdime New script a pak jesté jednou:
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L8 I LS 1]

1 A Arding @) 3
3

Is Search

Hrdina bude hybat kamerou, tak do tfidy pfiddme vefejnou proménnou
public Camera kamera;

a v okné Inspektoru do ni, po vybéru objektu Hrdina, pfetdhneme kameru Main Camera:

¥ = [¥Hrdina (Script) ["IEES

Script Hrdina @
Kamera #:Main Camera (Camera) @

Pohyb Hrdiny i kamery budeme fesit ve funkci Update(), tentokrit bychom chtéli, aby:

*  $ipka nahoru pfidévala rychlost ve sméru pohledu

* (moznd i Sipka doli ubirala rychlost ve sméru pohledu?)

*  pohyb mysi doleva nebo doprava ménil smér pohledu — a tim i smér pusobent sily
*  pohyb mysi nahoru a dold ménil dhel pohledu nahoru a dolt

Pridavéni a ubirdni rychlosti budeme fesit pisobenim sily metodou AddForce() a na konci nasta-
vime pozici a smér kamery podle pozice a sméru Hrdiny tak, jak jsme to délali v minulém projektu.

Ale abychom mohli na Hrdinu pusobit silou, potfebuje komponentu Rigidbody, proto mu ji

pfiddme:

MELNCN !
con
Is| < Physics
CookiyBox Collider
Mate \ capsule Colider
Masr‘character Contraller
¥ v [al# Character Joint
SCrRGy cloth
EVConﬁgurab\e Joint
& Constant Force
> ‘vF\xed Joint
——— Hinge Joint
|/ Mesh Collider

Sphere Collider
Spring Joint
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a aby se ndm pfi ndrazu Hrdina nepieklopil (spolu s nim by se pfeklopila i kamera), zafixujeme mu
rotaci podle os X a Z, takze se bude moci otdcet pouze podle svislé osy Y:

v A Rigidbody (VIR
Mass 1
Drag 0
Angular Drag 0.05
Use Gravity ¥4
Is Kinematic UJ
tnterpolare
Collision Detection
¥ Constraints
Freeze Position [JX (Y [JZ
Freeze Rotation (WX [|Y M2
» Info

Ve skriptu potom potiebujeme znit komponentu Rigidbody, abychom na ni mohli pusobit si-
lou — a abychom ji nemuseli hledat pokazdé, budeme si ji pamatovat v proménné, kterou naplnime
v metodé Start():

Rigidbody rb;

// Start is called before the first frame update
void Start()
{

rb = GetComponent<Rigidbody>();
Ovladani

Pokud jde o ovlidani pomoci kldves, to uz zndme — pouzijeme funkci Input.GetKey() s parame-

Funkce Input.GetAxis() s parametrem ,,Mouse X“ resp. ,Mouse Y* vriti rozdil, o kolik se po-
hnula mys v pfislusném sméru od posledniho zavoldni. A pfi pfistim zavolani uz bude vracet nulu,
dokud nepohneme mysi.

My udaje o pohybu mysi potfebujeme pro dva rizné ucely.

Kdyz hra¢ pohne my$i doleva nebo doprava, tak patfi¢né pooto¢ime Hrdinu, a tim jsme ten pohyb
spotfebovali a je dobfe, Ze pFisté bude nulovy.

Kdyz hra¢ pohne mysi nahoru nebo dold, chceme zménit thel kamery, piesnéji zarotovat ji podle
osy X a nechat ji tak otocenou, dokud hri¢ zase nepohne mysi. Protoze se kamera bude otdcet

110



— 6 Projekt Tyranosaurus

i do stran podle otd¢eni hrice, udélime to tak, Ze si v proménné mimo funkci Update() budeme
pamatovat celkové pootoceni smérem vzhiru a pohyb mysi k nému budeme jenom pficitat:

float rotaceOsyX = 0Of;

// Update is called once per frame
void Update()
{

float SILA = 1000f;

float POHLED = 5f;

if (Input.GetKey("up"))
{
rb.AddForce(SILA * Time.deltaTime * transform.forward);

}
float rotaceOsyY = Input.GetAxis("Mouse X");
rotaceOsyX += Input.GetAxis("Mouse Y");

// X a Y jsou spravne - doleva/doprava rotuje kolem osy Y
transform.Rotate (0, POHLED * rotaceOsyY, 0); // otocit se doleva/doprava

kamera.transform.position = transform.position;
kamera.transform.rotation = transform.rotation;
kamera.transform.Rotate (POHLED * -rotaceOsyX, 0, 0);

Takze se dokizeme Hrdinou pfemistovat po Roviné a mysi ménit smér pohledu i smér, kterym
budeme tlaceni silou (zkuste si tfeba dojet na kraj... a nespadnout).
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6.7 Sbirani minci a detekce kolizi

Vidéli jsme, Ze kdyz objektu piidime collider, tak na né&j bude pusobit fyzika a dokdze poznat, Ze
se srazil s jinym objektem, a patfi¢né reagovat. Alespoil zatim...

Collidery (nemédm Cesky pieklad a nechci ho nasilné vytvifet) mohou byt riznych druhg; ty, které
zatim jsou v na§i hie, jsou CapsuleCollider u Hrdiny a u Mince, BoxCollider u Zdi a MeshCo-
Ilider u Roviny. Kdyz pfi pohybu Hrdinou narazime do Mince, zarazi se o ni (no, moznd se zacne
pohybovat, o tom pozdéji). Ale v nékterych pfipadech nepotfebujeme, aby collider brénil pohybu
a stadi ndm jenom, kdyz se dozvime, Ze doslo ke kolizi. Jako pravé u Mince, kde mizeme Minci
sebrat, vydat zvuk a nechat Hrdinu pokracovat v cesté. Dosdthneme toho tim, Ze u doty¢ného
collideru zaskrtneme vlastnost IsTrigger, jako ted u prefabu Mince (u prefabu, protoze chceme,
aby to platilo pro viechny Mince):

¥ |y ¥ capsule collider [P -8
| & | Edit Colider
Is Trigger [
Material None (Physic Material) @

A protoze tusime, Ze se budeme potfebovat zeptat, s kym se kdo srazil, rozsifime si mnozinu zna-

ek (tag) a prifadime prefabim Mince a Zed odpovidajici tagy:

Root in Prefab Asset

¥ Mince o

Tag [Mince ] Layer |Defaut
voA T Untagged B
Position Respawn ']2
Rotatior Finish [z

Scale EditorOnly [z

MainCamera

I

Player
GameController

vildm

¥ Material ¥ Mince
Size Zed -
El B
EME - add Tag.

¥ Lighting

a objektu Hrdina jiz existujici tag Player.
Kdyz néjaky objekt, jako tfeba instance prefabu Mince, md né&jaky collider, bude se mu volat funk-
ce OnCollisionEnter(), pfipadné funkce OnTriggerEnter(), tedy pokud bude mit pfipojeny

néjaky skript a pokud tam tu funkci napiseme.

Takze kdyz prefabu Mince pfidime komponentu skript Mince a do néj pfidime nésledujici funkci:
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private void OnTriggerEnter (Collider other)

{
GameObject kdoKoliduje = other.gameObject;
Debug.Log($"Mince.Triger: tag: {kdoKoliduje.tag}");
gameObject.SetActive(false);

}

skript vypiSe pfi ndrazu Hrdiny do Mince zprivu
Mince. Triger: tag: Player
UnityEngine.Debug:Log(Object)
Mince:OnTriggerEnter(Collider) (at Assets/Mince.cs:16)

...a doty¢na Mince zmizi.

P1i kolizi se vold odpovidajici funkce u obou kolidujicich objektti a protoze sebrané mince bude
pocitat Hrdina, skript Mince miiZeme zase smazat. ..

...tedy pokud to udéldme, tak Unity poznd, Ze se prefab Mince odkazuje na neexistujici skript
a vyzve nds, abychom ten odkaz odstranili — coz udéldime v okné Inspektoru:

e ||
v Capsule - —

o cap Reset
5T Remove Component
s Trigger

gg Move Up
Material

| CariEr Move Down
"— Copy Component
X |5.96046¢

Radius Paste Component As New
Height Paste Component Values
Direction

Find References In Scene

¥ | (Script  Edit Script
Script Missing (Mono Script) 5]

The associated script can not be loaded.
Please fix any compile errars
and assign a valid script

MMince ﬁ x &,
» Shader [ standard -

...a misto toho pfiddme funkci do skriptu Hrdina:

private void OnTriggerEnter (Collider other)

{
GameObject kdoKoliduje = other.gameObject;
Debug.Log($"Hrdina.Triger: tag: {kdoKoliduje.tag}");

113



— 6 Projekt Tyranosaurus

kdoKoliduje.SetActive(false);

kterd vypise analogickou zpravu a zni¢i objekt, ktery dostala jako parametr.
Hrdina. Triger: tag: Mince
UnityEngine.Debug:Log(Object)
Hrdina:OnTriggerEnter(Collider) (at Assets/Hrdina.cs:47)

A protoze by takto mohl Hrdina nicit véechny objekty, Zdi ani Tyranosaura nevyjimaje, pfidime
k nicenf jesté¢ podminku a také pocitdni sebranych minci:

private void OnTriggerEnter (Collider other)

{
GameObject kdoKoliduje = other.gameObject;
Debug.Log($"Hrdina.Triger: tag: {kdoKoliduje.tag}");
if (kdoKoliduje.tag == "mince")
{
pocetSebranychMinci++;
kdoKoliduje.SetActive(false);
}
}

Pozndmka: Funkce SetActive() ve skutecnosti objekt nexnici, jen zneaktions; dalsi mognosti uvidime
casem.

Po zvyseni poctu sebranych minci by mél nasledovat test, jestli uz nejsou sebrané vechny, a pfi-
padné ohriostroje, fanfiry a konec hry — ale na to je jesté brzy.

6.8 Priprava Roviny

Na zacdtku hry potfebujeme pfipravit Rovinu, podobné jako v minulé hfe, tedy

*  rozmistit Zdi

*  rozmistit Mince

e umistit Hrdinu
* umistit Tyranosaura, aZ n&jakého budeme mit, pfipadné vice Tyranosaurti
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Pouzijeme na to skript Rovina, ktery pfipojime k objektu Rovina — a jeho funkci Start().
Nahoda

Vsechny zminéné objekty budeme umistovat nihodné, aby hra byla pokazdé jind, na druhou stra-
nu by nebylo §patné dovolit hraci, aby si znovu zahril stejnou hru, pfipadné hru, kterou hrél jeho
kamardd. Vyfesime to tak, Ze ndhodnému generatoru budeme na zac¢itku nastavovat ndhodné
seminko — a to si bude (pozdéji) hra¢ moci zvolit. Se stejnym seminkem bude nahodny generator
generovat stejnou posloupnost nahodnych &isel, ze kterych postavime stejnou scénu.

Takze objektu Rovina pfidime komponentu skript, ktery pojmenujeme Rovina, a odpovidajici-
mu objektu pfiddme celoéiselnou proménnou:

public int CisloHry = 12345;

v | ¥ Rovina (Script) -
Script Rovina o
Cislo Hry 12345 |

Protoze budeme ve skriptu potiebovat jesté znit prefaby Zed a Mince, vytvofime proménné i pro
né a v okné Inspektoru do nich pfetihneme odpovidajici prefaby. A nakonec totéz i pro Hrdinu,
kterého tam také pretdhneme:

public int CisloHry = 12345;
public GameObject PrefabZed;
public GameObject PrefabMince;
public GameObject Hrdina;

v | ¥Rovina (Script) ["IEES
Script Rovina o
Cislo Hry [12345 |
Prefab Zed ’vZed—| (]
Prefab Mince ‘WMnce e
Hrdina (Hrdna @

Generovani objektu

Zdi (i Mince i Hrdinu) rozmistime nihodné a abychom neumistili dvé Zdi do stejného mista,
a abychom to nemuseli dopfedu hlidat, budeme je poustét z vysky a spoléhat na to, Ze se pfi padu
néjak srovnaji. Aby ovéem padaly, musime prefabu Zed pfidat komponentu Rigidbody; zatim

neménime zidné jeji vlastnosti, moznd Casem:
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1
I v & Rigidbody K
Mass ]
Drag |0 |
Angular Drag 10,05 |
Use Gravity I~
[s Kinematic ;)
Interpolate [ None =
Collision Detection [ Discrete A
¥ Constraints
Freeze Position []X (Y []Z
Freeze Rotation [JX [JY [JZ
» Info

Hodilo by se nim také udélat ohradku na okraji Roviny, aby Hrdina nemohl piepadnout. Ale Ro-
vina je tentokrdt vétsi a kdyz bychom skladali ohrddku z jednotlivych kostek zdi, bude jich hodné
a budou zbyte¢né zatézovat procesor i pamét. Proto pro kazdou stranu ohridky pouzijeme jenom
jednu instanci prefabu Zed, kterou patfi¢né roztdhneme.

A kdyz uz budeme ménit vlastnosti instance, zvétsime i jeji vahu (vlastnost mass), aby se nestalo,
ze padajici Zdi ohradku odsunou:

void Start()
{
Collider collider = GetComponent<Collider>();
Vector3 velikost = collider.bounds.size;
// spoleham na to, ze velikost.x==velikost.z
float minxz = -velikost.x / 2+1;
float maxxz = velikost.x / 2-1;

float kamy = 0.5f;

GameObject zed;

zed = Instantiate(PrefabZed, new Vector3(0, kamy, minxz), Quaternion.identity);
zed.transform.localScale = new Vector3(velikost.x, 1, 1);
zed.GetComponent<Rigidbody>() .mass = 1000;

zed = Instantiate(PrefabZed, new Vector3(0, kamy, maxxz), Quaternion.identity);
zed.transform.localScale = new Vector3(velikost.x, 1, 1);
zed.GetComponent<Rigidbody>() .mass = 1000;

zed = Instantiate(PrefabZed, new Vector3(minxz, kamy, 0), Quaternion.identity);
zed.transform.localScale = new Vector3(l, 1, velikost.z - 4);
zed.GetComponent<Rigidbody>().mass = 1000;
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zed = Instantiate(PrefabZed, new Vector3(maxxz, kamy, 0), Quaternion.identity);
zed.transform.localScale = new Vector3(l, 1, velikost.z - 4);
zed.GetComponent<Rigidbody>().mass = 1000;

Na Rovinu chceme také pfidat instance prefabu Zed jako ptekizky, které budou Hrdinovi (i Tyra-
nosaurovi) brnit ve vyhledu — proto ndm nezalez{ pfesné na tom, jak budou rozmistény a budeme
je rozmistovat pomoci nahodného generdtoru, ktery nastavime podle Cisla hry.

Abychom ale nevytvareli pfili§ mnoho instanci, tak podobné jako u zdi tvoficich ohridku budeme
ménit velikost vytvofené instance, feknéme na desetindsobek:

Random.InitState(CisloHry);
float K = 10f;

int pocetPrekazek = (int) (0.3 * velikost.x / K * velikost.z / K);
for (int i = 0; i < pocetPrekazek; i++)

{
float x = Random.Range (minxz+K, maxxz-K);
float z = Random.Range(minxz + K, maxxz - K);
float y = (i + 2) * K; // nechame je padat z vysky
zed = Instantiate(PrefabZed, new Vector3(x, y, z), Quaternion.identity);
zed.transform.localScale = new Vector3 (K, K, K);
}

Vysledek pii pohledu z vysky vypada takhle:
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a pii pohledu hrdiny takhle:

Je to dost strasidelné?

6.9 Poloha Minci a Hrdiny
Bude potfeba nékam umistit Mince a Hrdinu a nemélo by to byt v misté, kde je néjakd Zed.

Kdybychom jednotlivé Zdi umistovali na pevné pozice, tak bychom si mohli pamatovat jejich
polohy a mista pro Mince a pro Hrdinu potom hledat tak, aby nekolidovala s Zidnou zdi. Jenomze
kdyz spoléhdme na fyziku a nechime jednotlivé Zdi padat a kutdlet se, tak nedokdzeme ve chvili
generovani Fici, kde kterd Zed nakonec bude stit. Co s tim?

Je to hra, ne fizeni jaderné elektrarny, tak si miizeme dovolit zkusit feSeni, které tfeba nékdy selze.
Jestli chceme, aby se Mince a Hrdina dostali k Roviné az potom, co tam budou véechny Zdi, ne-

chdme je také padat z vysky a to z vétsi vysky, nez vSechny Zdi.
Co se muze stat nejhorsiho?

Pokud Hrdina dopadne na néjakou Zed, tak miize skocit doli, tedy az se vynadivd; berme to jako
necekany bonus.

Pokud Mince dopadne na né&jakou Zed, mohla by byt pro Hrdinu nedostupna a jestli bude mit
Hrdina za tkol najit véechny Mince, hra by nesla vyhrat. MiZeme to ale vyfesit tak, Ze pocet
Minci, které Hrdina musi sebrat, bude na zacatku nastaveny na nulu a bude se zvySovat o jedna

pokazdé, kdyz se n€jakd Mince dotkne zemé (Roviny).
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Pokud by Hrdina nebo Mince dopadli na dvorek obklopeny Zdmi, ze kterého neni uniku, pak

mdme smilu, ale nefidime jadernou elektrarnu...

Vytvoreni Minci a umisténi Hrdiny

Kdyz vytvofime Mince vysoko nad instancemi Zdi — tak tam zistanou! Protoze nemaji kompo-
nentu Rigidbody a tedy nepadaji. Takze ji pfidime, opét bez jakychkoliv zmén parametri. A kdyz
uz jsme v okné Inspektoru, tak vytvofime novy tag Rovina a nastavime ho objektu Rovina, aby se
Mince mohla zeptat, kam to dopadla:

Problém: Propadavani

© Inspector

¥ [Rovina | (] Static = -
" Tag [Rovina 4] Layer [ Default 3]
v i Tr Untagged W EES
Position Respawn
Rotatior Finish
Scale EditorOnly
MainCamera
Player

v M GameController 3,
¥ Material Mince

Sze  Zed I

Eleme «»  Rovina @
¥ Lighting

Cast ! Gdd)lag | 3]

Kdyz se podivime na padajici Mince, mizeme pozorovat, Ze (nékteré) propadnou Rovinou a pa-
daji dél. Prvni dtvod je zagkrtnuta vlastnost IsTrigger,

v i ¥ capsule Collider

Q=

Edit Collider
74

Is Trigger
Center

X [5.960464e-|Y [0 |z [-8.540657¢]
Radius [0.5000001 |
Height 2 |
Direction [ r-Axis s

kterd fikd, Ze tento collider nema kolize sdm fe$it a md nim jenom dét védét. Takze tuto vlastnost
(zaskrtli jsme ji na samém zacatku) zase odskrtneme a jestli jsme tu zménu udélali jen u jedné

instance a ne u prefabu, miZzeme v okné Inspektoru kliknout na tla¢itko Overrides,
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!
© [nspector

' ¥ Mince | (] static = -
Tag [ Mince + | Layer | Default i)
Prefab | open | Select | [Overrides -

které ukdze, ¢im se tato instance lisi od prefabu:

G g e ) ,

)
_‘ Overrides to wMince
in €Scene

v e Mince
i Capsule Collider

@ Click on individual items to review, revert and apply.

-

[ Revert All ] [ Apply All _]
LE |

a mizeme si vybrat budto viechny zmény vratit (Revert All) nebo naopak viechny zmény pro-
mitnout do prefabu (Apply All) — a to je to, co chceme.

Pokud ndm pofdd nékteré mince dél propadavaji Rovinou, pomutize odebrat Roviné MashColli-
der a pridat ji BoxCollider, kterému navic zménime vysku a potom o polovinu vysky (MashCo-
llider mél vysku nulovou) posuneme umisténi dold, aby nezastavoval objekty pil své vysky nad
povrchem Roviny:

¥ I ¥ Box Collider o &
Edit Collider
Is Trigger |
Material Neone (Physic Material) | @
Center
X[0 |y [-0.5 |z [o |
Size
X[10 [¥ [T |z [10 |

Skript Mince

Minci potom pfiddme skript Mince a protoze jeji collider uz neni trigger, bude kolize vyvolévat
jinou funkci.

Ted uz by mince propadat nemély, ale pro vSechny piipady ponechime Minci i funkei Update()
a pokud by né&jakd Mince propadla Rovinou nebo pfepadla pfes okraj, v urité hloubce ji zlikvidu-

jeme a zmensime celkovy pocet minci k sebrani. Usetiime tim strojovy ¢as:
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public class Mince : MonoBehaviour

{
static int ZbyvaSebrat = 0;

void OnCollisionEnter(Collision collision)

{
GameObject kdoKoliduje = collision.gameObject;
if (kdoKoliduje.tag == "Rovina")
{
ZbyvaSebrat++;
}
if (kdoKoliduje.tag == "Player")
{
ZbyvaSebrat--
//TODO: zahrat zvuk
Destroy(gameObject) ;
}
}

// Update is called once per frame
void Update()

{
if (transform.position.y < -10)
{
ZbyvaSebrat--
Destroy(gameObject) ;
}
}

Pozndmka: Proménnd ZbyvaSebrat je oznacena jako static, profoze to neni promeénnd, kterou by si
pamatovala kazdd Mince, ale jedna spolecnd proménnd pro celou tvidu.

Jesté odstranime jednu instanci Zdi, kterd je od zacdtku umisténd ve scéné —a mizZeme hru spustit:
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6.10 Problém: Otaceni pfi narazu

Pokud bychom se setkali s tim, Ze se pfi ndrazu do jiného objektu Hrdina za¢ne oticet, pomuze

mu v komponenté Rigidbody zvysit thlové tfeni (Angular Drag) z ptivodnich 0.05 tieba na 1:

| ¥4 Rigidbody TR
Mass |1 |
Drag |0 |
Angular Drag |1 ]
Use Gravity
Is Kinematic ]
Interpolate [ None s
Collision Detection [ Discrete s
I ¥ Constraints
Freeze Position [)X [(JY [)Z
I Freeze Rotation (X [(]Y 2

Takze mame ptekdzky, mince, hrdinu, mizZeme hrit. Vypadd to docela strasidelné — a to si jesté
piedstavte, Ze se tu nékde potuluje tyranosaurus!
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7 Objekt Tyranosaurus
7.1 Priprava

Tyranosaura nejdfive vyrobime, pak osetfime, aby Hrdina reagoval na kolizi s nim — a aZ to vSech-
no bude fungovat, nau¢ime Tyranosaura chodit.

Kdybychom chtéli odbocovat, mohli bychom si Tyranosaura vymodelovat v Blenderu, nejspise
bychom né&jakého také nasli ke stahnuti. Protoze nechceme odbocovat, bude Tyranosaurus jenom
koule piejmenovand na Tyranosaurus, trochu zvétSend a s Cervenym materidlem MTyranosau-
rus. A protoze moznd bude Tyranosauri vice, pfetahneme ho z okna Hierarchie do okna Assets
a tim z néj vyrobime prefab:

| Assets

m.  UE GOS0  EW

Scenes FMHrdina  Hrdina  MHrdina  Mince  Mince  MMince  MRovina  MTyranosa..  MZed  Rovina

Ted udélime nékolik (programovacich) kroki, které vyuzijeme k zapojeni Tyranosaura do hry, ale
které budeme muset oSetfit jinak, aZ bude Tyranosari vice. V¢as na to upozornime.

Aby se Tyranosaurus mohl pohybovat, pfiddme mu komponentu skript pojmenovanou také Tyra-
nosaurus a protoze bude potiebovat védét, kde je Hrdina, pfidime do skriptu parametr

public class TYranosaurus : MonoBehaviour
{

public GameObject mujHrdina;

a v okné Inspektoru do néj pfetdhneme Hrdinu (tady bude pozdéji problém, dojdeme k tomuy):

Il :

v | ¥ Tyranosaurus (Script) @ 3 % 2 [Tyrancsaurus (] Static =
Script Tyranosaurus Q Tag [Tyrancsaurus__ ¢ | Layer | Default 4]
Muj Hrdina [ Hrdina | o YA T Untagged [T

Position Respawn Nz s
i — = Rotatior Finish —]Z 0
Scale EditorOnly [z 2

MainCamera Q3%
Player @

A nakonec je§té rozsifime mnozinu znacek a prefabu(!) Ty-

ranosaurus piiddme tag Tyranosaurus: vl M  GameController ELC
¥ Material Mince
Size Zed
Eleme Raovina S ]
Y Lghtng o Tyranosaurus
Cast ! 4
as P )

Receil

125



— 7 Objekt Tyranosaurus

7.2 Zapojenido hry

Zactneme tim, Ze se objekt Tyranosaurus nebude pohybovat, jenom ho/je ve skriptu Rovina vytvo-
fime a umistime do scény a také nau¢ime Hrdinu reagovat na kolizi s Tyranosaurem.

Kdyz uz budeme ve skriptu Rovina vyrabét a umistovat Tyranosaura, mizeme jich rovnou vyrobit
a umistit vice, takZe skriptu Rovina pfiddme vefejnou proménnou PocetTyranosauru s piedvypl-
nénou hodnotou a také proménnou PrefabTyranosaurus, abychom mohli vyrdbét nové instance:

public class Rovina : MonoBehaviour
{
public int CisloHry = 12345;
public GameObject PrefabZed;
public GameObject PrefabMince;
public GameObject Hrdina;
public int PocetTyranosauru = 3;
public GameObject PrefabTyranosaurus;

a v okné Inspektoru do ni pfetdhneme odpovidajici prefab:

¥ |« ¥ Rovina (Script) @3

Script Rovina o]
Cislo Hry [12345

Prefab Zed [wzed |
Prefab Mince [@Mince |
Hrdina [OHrdna ]
Prefab Tyranosaurus|iyTyranosaurus |

Pocet Tyranosauru 3 |

O 0 60 06

Vlastni vytvofeni a umisténi potom bude podobné jako vytvofeni a umisténi Hrdiny, soufadnice
X a Z budeme generovat nihodné a hotové Tyranosaury budeme shazovat z vysky a doufat, Ze se
s pomoci fyziky néjak srovnaji.

Mohli bychom ale ohlidat, abychom nevytvofili Tyranosaura pifili§ blizko Hrdiny, aby Hrdina
nebyl sezrdn diive nez se staci rozhlédnout, proto vyuzijeme toho, Ze si pii vytvifeni pamatujeme
soufadnice Hrdiny, a u vygenerovanych soufadnic pro Tyranosaura budeme kontrolovat, jestli
nejsou moc blizko (i kdyz se tam stejné mizou po padu dokutilet):

float minimalniVzdalenostOdHrdiny = 10f;
Vector2 hrdinaXZ = new Vector2(hx, hz);
for (int i = 0; i < PocetTyranosauru; i++)

{
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float tx;
float tz;

do
{
tx = Random.Range(minxz + 1, maxxz - 1);
tz = Random.Range(minxz + 1, maxxz - 1);
} while (Vector2.Distance(new Vector2(tx, tz), hrdinaXZ)
> minimalniVzdalenostOdHrdiny) ;

float ty = hy + 5 + 2 * 1i;

Instantiate(PrefabTyranosaurus, new Vector3(tx, ty, tz), Quaternion.identity);

7.3 Ladéni v Unity
Kdyz hru spustime, mizeme vidét, jak padaji Zdi, padd Hrdina, padaji Mince — a nepadaji zidni
Tyranosauii! Jisté, je to proto, Ze nemaji komponentu Rigidbody a tedy na né neptsobi gravitace,

ale ukdZeme si u toho, jak nim Unity miZe pomoci pfi ladéni.

Kdyz hru spustime, moznd mdme a mozna nemdme zamécknuty pfepina¢ Maximize On Play:
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Pokud méme, tak si ho od-mackneme a to ndm dovoli v bézici hfe pouzivat stejné nistroje jako

pii vytvifeni scény, tieba okno Hierarchie, kde vidime vSechny objekty:

(u opravdového programu bychom si méli pfipravit
prazdné objekty — pfihridky na ruzné typy objektd
a vyrdbét instance do nich, ne takhle vSechny vedle
sebe!). Vidime i okno Scény, kde mizeme hybat kame-
rou i jednotlivymi objekty:
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A nakonec i okno Inspektoru, kde mizZeme vidét i ménit vlastnosti vybraného objektu:

@ Inspector

¥ Tyranosaurus(Clone) | [ static +
Tag [ Tyrancsaurus  # | Layer | Default i
¥ A Transform 36,

Position X 34‘0991‘( 359 Z|-39.00
Rotation X0 ¥ [o 1z [0 ]
Scale X2 ¥ [2 1z [2 ]

¥ . Sphere (Mesh Filter TN
Mesh o

¥ . ¥Mesh Renderer R -5

- AAbniale

7.4 Zpatky k Tyranosaurim

Takze prefabu Tyranosaurus pfidime komponentu Rigidbody a ted uz ve hfe muZeme narazit
na Tyranosaura:

Kdyz na n&j Hrdina opravdu narazi, tak se Tyranosaurus odkutdli, proto upravime skript Hrdiny:

void OnCollisionEnter(Collision collision)

{
GameObject kdoKoliduje = collision.gameObject;
if (kdoKoliduje.tag == "Tyranosaurus")
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//T0DO: zvuk
rb.velocity = (50*Vector3.up);

}

Tyranosaurus nakonec hraci nebude ubirat Zivot, jenom ho vystieli do vysky, ¢imz hra¢ ztrati
néjaky Cas, na druhou stranu se bude moci z vysky rozhlédnout a pfipadné i sebrat néjaké mince,
které nedopadly na zem:

7.5 Pohyb Tyranosaura

Tyranosaurus nemusi byt zvldst inteligentni. V kazdém kroku se podiva, jestli vidi Hrdinu — a po-
kud ano, vydd se k nému. Pokud ne, tak bude pokracovat k mistu, kde naposledy vidél Hrdinu.
Pokud uz tam dosel nebo Hrdinu jesté nevidél, vybere si ndhodné smér a vyda se tam, jako by tam
predtim vidél Hrdinu.

Problém: Parametr skriptu u prefabu

Ted pfijde ta zména, na kterou jsme upozortiovali vyse pii vytvafeni skriptu Tyranosaurus:

Skript Tyranosaurus potiebuje ptistup k objektu Hrdina. KdyZ jsme ho pfed chvili nastavovali
pro konkrétni instanci Tyranosauta, tak nebyl problém, jen jsme vybrali a pfetdhli objekt Hrdiny
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nebo kliknuli na ikonku a vybrali z menu. Ale kdyZ to chceme nastavit u prefabu, tak to nejde.
Proto odkaz Tyranosaura na Hrdinu nakonec budeme ziskdvat az za béhu ve funkci Start():

GameObject mujHrdina;
Vector3 kdelJsemNaposledyVidelHrdinu;
Rigidbody rb;

// Start is called before the first frame update
void Start()

{
mujHrdina = GameObject.FindGameObjectWithTag("Player");
kdeJsemNaposledyVidelHrdinu = Vector3.zero;
rb = GetComponent<Rigidbody>();

}

Zpusobu, jak najit objekt, je fada; tady se ndm hodi moznost vyhledat objekt podle hodnoty vlast-

nosti tag. Konec problému.

Vlastni pohyb by se potom mohl fidit algoritmem popsanym vyse, ale potiebujeme, aby se tak Ty-
ranosaurus zacal chovat teprve potom, co dopadne na Rovinu, proto pfiddme proménnou a reakci
na kolize:

bool uzDopadl = false;
void OnCollisionEnter(Collision collision)

{
if (collision.gameObject.tag == "Rovina")
{
uzDopadl = true;
}
}

Vlastni pohyb Tyranosaura potom bude vypadat takto:

// Update is called once per frame
void Update()

{
if (uzDopadl == false)
{
return;
}
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float RYCHLOST = 20f;
float BLIZKO = 1f;
float KROK = 2f;

// jestli vidim Hrdinu:
RaycastHit hit;

Vector3 smer = mujHrdina.transform.position - transform.position;

if ((Physics.Raycast(transform.position, smer, out hit))

&& (hit.collider.gameObject.tag == "Hrdina"))
{
kdeJsemNaposledyVidelHrdinu = mujHrdina.transform.position;
rb.velocity = Time.deltaTime * RYCHLOST * smer.normalized;
}

else // pokracovat ve smeru, pokud tam jeste nejsem
if ((transform.position-kdeJsemNaposledyVidelHrdinu).sqrMagnitude>BLIZKO)

{
smer = mujHrdina.transform.position - transform.position;
rb.velocity = Time.deltaTime * RYCHLOST * smer.normalized;
}
else // uz jsem tam dosel a Hrdinu nevidim => zvolit si novy cil
{
float uhel = Random.Range(0f, Mathf.PI * 2);
kdeJsemNaposledyVidelHrdinu
= new Vector3(KROK * Mathf.Sin(uhel), 0, KROK * Mathf.Cos(uhel));
}

Proti pivodnimu pldnu tyranosaurus neni rychlejsi nez hrdina, ale i tak to stali na strasidelnou
atmosféru.

Pozndmka: 1i viastnost .normalized vektoru smer vract normalizovanou hodnotu — tedy vektor o ve-
likosti jedna. Kdybychom ji nepouzili a nastavovali rychlost podle smer, znamenalo by fo, Ze ke vzda-
lenéjsimu Hrdinovi pobézi Tyranosaurus rychleji a naopak k blizkému pijde po-ma-lu a skonci jako
rychlonohy Achilles, ktery nemiize dohonit Zelvu.
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7.6 Svétlo
Kdyz tak hrdina chodi po zdkoutich nasi hry a hledd mince — tak tam neni moc dobfe vidét.

Je to hra, tak si mizeme Fici, Ze to je soucdst herniho zazitku. Nebo mu miizeme dit do ruky
baterku.

Svétlo a préce s nim je obecné slozita zdleZitost, my udéldme jen to, Ze v okné Hierarchie vyrobime

novy objekt typu Spotlight:

Copy

Paste

Rename

Duplicate

Delete

Select Children
Select Prefab Root

ditor ™

Create Empty 'Hrdina.pocetSebranychMinc!
3D Object >

2D Object >

Effects >

Light > Directional Light

Audio > Point Light

Video > Spotlight

ul > Area Light

Camera Reflection Probe

Light Probe Group

Pojmenujeme ho Baterka, trochu mu upravime vlastnosti (zvétsime thel a intezitu svétla):

v '\ [MLight @
f

Type Spot

Range 10 |
Spot Angle — — | G0
coor —
Mode [ Realtime -]
Intensity | —

Indirect Multiplier 1

do skriptu Hrdina pro néj pfiddme vefejnou proménnou
public Light baterka;

V okné Inspektoru do ni pfetaihneme objekt Baterka:

133



— 7 Objekt Tyranosaurus

¥ = [MHrdina (Script) Q@ = =
Script Hrdina Q
Kamera #Main Camera (Camerz @
Baterka Baterka (Light) o
- A o [

a jako posledni krok — ve skriptu Hrdina tam, kde ménime pozici a orientaci kamery, budeme
analogicky nastavovat i pozici a orientaci baterky, miizeme rovnou pouzit hodnoty z kamery:

kamera.transform.position
kamera.transform.rotation

transform.position;
transform.rotation;

kamera.transform.Rotate (POHLED * -rotaceOsyX, 0, 0);

baterka.transform.position
baterka.transform.rotation

kamera.transform.position;
kamera.transform.rotation;

Potom pohyb hrdiny v temnych uli¢kdch vypada takhle:

ale moznd je to zmeékeilost a také bychom to mohli zapinat a vypinat jenom kdyz si to hrdina
muzZe dovolit, tfeba na omezenou dobu nebo podle sebranych minci.

Také mizZeme experimentovat s nastavovinim parametra svétla, nebo s jinymi typy svétel.

134



8 Scény






— 8 Scény

8 Scény
8.1 Zamysleni

Na zacdtku préce na této hie jsme vyrobili tfi scény a pak jsme se vénovali jen scéné Hra. Ted se
pojdme podivat na ty ostatni a na pfechody mezi nimi a mozna si také trochu ujasnit pravidla

acil hry.
Pravidla a cil

Hrdina chodi v bludisti, hledd mince a utikd pfed tyranosaurem. Ale to neni cil, tak to zkusme
zformulovat 1épe. Sebrat vSechny mince — se ndm nemusi podafit, protoze i kdyz jsme si dali praci
s pocitdnim, kolik minci dopadlo na zem, nékteré mohou byt nedostupné mezi (nebo pod) zdmi
a naopak, diky ,vykopnuti“ od tyranosaura muze hrdina sbirat i mince, které zustaly lezet nékde
nahofe na zdi. Pokud tedy nemuzeme zarucit, Ze pijdou sebrat vSechny mince, mohlo by byt cilem
sebrat jich co nejvic. A aby se vysledky her daly porovnévat, zapojime do toho jesté ¢as, tedy sebrat
co nejvice minci za co nejkratsi dobu. A kdyZ mdme dvé kriteria, mince a dobu, neni jasné, co je
lepsi; budto bychom mohli vysledek brit jako dvojici (mince, doba) a porovnévat ho lexikograficky

nebo muzeme stejného efektu dosdhnout tim, Ze to pfevedeme na jedno &islo, tieba takhle:
skore = 1000*sebrané_mince — doba

Prvni scéna - Uvod

Na prvni scéné by si mél uzivatel nastavit nebo vybrat parametry hry, tedy

*  &slo hry (ndhodné seminko)

* pocet tyranosaurQ

e pfipadné jejich rychlost

Ale nastavovat si pfili§ mnoho parametrd neni zabavné, navic by bylo tézké mezi sebou porov-

ndvat vysledky téZe hry s jinym poctem nebo jinou rychlosti tyranosaurt. Proto to zase spojme

do jednoho disla, tieba tak, Ze se bude zaddvat jenom Cislo hry, pficemz prvni ¢islice bude udavat

pocet tyranosauri a druhd jejich rychlost, takze tfeba hra &islo 12345 bude obsahovat jediného

tyranosaura s rychlosti dva.

Kromé pole (nebo seznamu) pro zaddvini (nebo vybér) &isla hry uz bude prvni hra obsahovat
pouze tlaéitko, které hru spusti.

A krom toho tam miize byt fada nefunkénich prvkua jako navod k pouziti, obrizky apod.
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Posledni scéna - Konec

Posledni scéna by méla ukdzat dosazené skére, piipadné zebricek nejvyssich skére pro hru da-
ného disla — a tla¢itko pro pfechod na scénu Uvod, aby uzivatel mohl hrit znovu a pfipadné si
vybrat jinou hru.

8.2 Pretrvavajici objekty

V kazdé scéné se na zacitku vytvofi jeji objekty — a pfi nahrdni nové scény se zni¢i. Coz je mrzuté,
protoze potiebujeme ze scény Uvod pfenést vybrané &islo hry do scény Hra a z ni zase pfenést
vysledné skére do scény Konec. Unity nabizi feseni v podobé funkce DontDestroyOnLoad(),

kde parametrem je objekt, ktery se nemd nicit pfi pfechodu mezi scénami.

V okné Hierarchie vyrobime novy prazdny objekt:

Copy
Paste
Rename
Duplicate
Delete

Select Children
Select Prefab Root

Create Empty a pfejmenujeme ho na Data:
3D Object >
1 2D Object >
r Effects > i= Hierarchy
- | Create 'l ”C\'AH—
Light ’ v Q Uvod =
Audio > |/ Main Camera
Video > |/ Directional Light
ul 3 > QCanvas
| EventSystem
Camera

Objektu Data pfidime komponentu — skript Data a do néj pfiddme vefejné proménné pro hod-
noty, které budeme chtit udrzovat mezi scénami:

public class Data : MonoBehaviour
{
public int CisloHry;
public int SebranychMinci;
public float DelkaHry;
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Aby objekt Data zistal zachovin mezi scénami, pfiddime mu funkci Awake(), s volanim jiz zmi-
néné funkce DontDestroyOnLoad:

void Awake()

{
DontDestroyOnLoad(this.gameObject);

Funkce Awake() se vold po nacteni instance skriptu a zavold se dfive nez kterakoliv z funkei

Start().

8.3 Zpatky k prvni scéné

Vybereme tedy prvni scénu Uvod a vlozime do ni ovlddaci prvky. Nejprve Canvas, kterému na-
stavime rezim vykreslovini na Screen Space — Overlay:

v|i| I canvas % E:::ajfhfi—,m* ?hif:ﬁne
Render Mode Screen Space - Overlay = vQUVUd*
Pixel Perfect m ___/Main Camera
Sort Order ‘0 | _ | Directional Light
Target Display [ Display 1 :] | EventSystem
Additional Shader Ch[ Nothing 4]
Cislo hry
. . . Text
Dile v okné Hierarchie pfidime (md- Copy Text - TextMeshPro
zeme ho pfidat kamkoliv, ale zafadi se Paste ::’agle
. . aw Image
pod objekt Canvas) objekt Dropdown — RDE"TT”ET Button
A uplicate
TextMeshPro z kategorie UI: Delete Button - TextMeshPro
Toggle
Select Children Slider
Select Prefab Root Scrollbar
Create Empty Dropdown
3D Object > Dropdown - TextMeshPro
2D Object > Input Field
@ Project I Effects > Input Field - TextMeshPro
| Create v‘ Light > Canvas
¥ i (Favoritt  audio > Panel
QA” L Video > Scroll View
Al Mo
Q All Pre ul > Event System

Camera v W
— S A mmate
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a v okné Inspektoru mu nastavime nékolik moznych ¢isel her jako hodnoty parametru Options:

@ Inspector
ixels Per Unit Mu
|| TMP_Dropdown (Script) I
Interactable 4
Transition [ Color Tint s

Target Graphic *,Dropdown (Image)
Normal Color
Highlighted Color
Pressed Color

Selected Color
Disabled Color

SRR

Color Multiplier — Om—— 1
Fade Duration 0.1 ]
Navigation [ Automatic el
[ Visualize ]
Template o Template (Rect Trans
Caption Text |T|Label (TextMeshProUt
Caption Image Mone (Image)
Item Text [TlItem Label (TextMes
Item Image Nore (Image) Soufadnice nastavime na stfed obrazovky:
Value 0 ]
R @ Inspector
=B !
'None (Sprite} le o £ u -
Tag [ Untagged 4] Layer [ur i)
- [99001 I Vgg Rect Transform o8,
[EnElS A E] | o e PosX PosY PosZ
— [51007] ] 2 [0 o Jlo ]
None (Sprite) ] 3z Width Height
I*—_ ¥ Anchors
Min vine  Iwlnc 1

a kdyz hru zkusime spustit, mame vybiraci seznam:

/12345
99001
9100
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K tomu, jak ziskat vybrané ¢&islo hry, se dostaneme pozdéji.

Tlaéitko Start

Nakonec pfiddme tlacitko (tentokrat ne z knihovny TexMesh Pro, i kdyz to by slo také):

Copy
Paste
Rename
Duplicate
Delete

Select Children
Select Prefab Root

Create Empty
3D Object
2D Object
Effects

Light

Audio

Video

Camera

...a pfejmenujeme ho na TlacitkoStart.

Text
Text - TextMeshPro
Image

Raw Image

Button - TextMeshPro
Toggle

Slider

Scrollbar

Dropdown

Dropdown - TextMeshPro
Input Field

Input Field - TextMeshPro
Canvas

Panel

Scroll View

Event System

Pokud chceme zménit text, ktery je na ném napsin, vSiimneme si, Ze tlalitko v okné Hierarchie

mé podtizeny objekt Text:

A ten objekt je to spravné misto, kde zménit text zob-
razeny na tlacitku a pfipadné i fadu jinych vlastnosti:
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Pro tlagitko si vyrobime skript, pojmenujeme ho TlacitkoStart.

Pozndmka: Pokud by nds napadlo pojmenovat si ten skript Button, jako to délime u ostatnich objekti,
nent to dobry ndpad,

//!!! tohle NE !'!!
public class Button : MonoBehaviour

{
public Button tlacitko;

protoZe v takovém pripadé ndazev tridy skriptu (Button) zastini typ pro tlacitko (taky Button) a potom
ten pridany parametr tlacitko nebude typu Button-tlacitko, ale Button-skript. Pomoblo by u proménné
tlacitko uvést typ celym jménem, tedy UnityEngine. UL Button namisto Button, ale stejné je lepsi si
skript pojmenovat jinak.

Novému skriptu pfidime vefejnou proménou

public class TlacitkoStart : MonoBehaviour

{
public UnityEngine.UI.Button tlacitko;
pietdhneme do ni objekt tladitka: v o ¥Button (Script) @
Interactable 4
_ Transition | color Tint 4]
v« |¥ Tlacitko Start (Script) E‘ R - Target Graphic "aTlacitkoStart (Image) @
Script TlacitkoStart 2] Normal Color v
Tlacitko ~ TlacitkoStart (Button, © Al S Z
Pressed Color &
- Selected Color P4
Disabled Color | 2
Color Multiplier O 1 |
Pozndmka: Samotny objekt typu Button uz ob- e PurEiEn | |
sahoval komponentu-skript pojmenovany Button, Navigation [ Automatic 4]
takze kdybychom ponechali pivodni nazev, miiZe ( plaLalze J
v tom navic byt trochu zmatek. Ceské identifikdtory on Click ()
nékdy maji své vyhody. List is Empty
| + -
v = ¥ Tlacitko Start (Script) Q=
Script TlacitkoStart Q
| Tlacditko « TlacitkoStart (Button] @
I
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Ve funkci Start() potom nastavime, aby tlacitko pfi kliknuti zavolalo nasi funkci:

void Start()

{
tlacitko.onClick.AddListener (KLIK);

... a KLIK() je funkce, ze které nastartujeme hru.

K tomu budeme potiebovat jesté zjistit vybranou hodnotu v objektu Dropdown... ...jenomze
nastartovat hru (a tedy pfejit do jiné scény) je néco, co by se nemuselo odehravat jen tak v néjaké
funkei obsluhujici kliknuti. Proto funkei pro start hry pfidime do skriptu Data a tady ji jenom
zavoldme. Jenomze zase (vyvoj programu neni snadnd zalezitost!), aby se skript dostal k objektu
Data, bude si ho muset najit:

void KLIK()
{
Data data = FindObjectOfType<Data>();
data.GetComponent<Data>().ZacniNovouHru(); ();
Slo by to napsat i bez proménné, do jednoho ptikazu, ale takhle mi to pfijde pfehlednéjsi.

Ta voland funkce vypada takhle:

public void ZacniNovouHru()

{
TMPro.TMP_Dropdown dropdown = FindObjectOfType<TMPro.TMP_Dropdown>() ;
string sCisloHry = dropdown.options[dropdown.valuel].text;
CisloHry = int.Parse(sCisloHry);
PocetTyranosauru = int.Parse(sCisloHry.Substring(0, 1)); // prvni cislice
RychlostTyranosaura = int.Parse(sCisloHry.Substring(l, 1)); // druha cislice
UnityEngine.SceneManagement.SceneManager.LoadScene("Hra");

}

a nebude fungovat,
Scene ,Hra‘ couldn‘t be loaded because it has not been added to the build settings or the

AssetBundle has not been loaded.
To add a scene to the build settings use the menu File->Build Settings...
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UnityEngine.SceneManagement.SceneManager:LoadScene(String)
Data:ZacniNovouHru() (at Assets/Data.cs:24)

TlacitkoStart: KLLIK() (at Assets/TlacitkoStart.cs:19)
UnityEngine.EventSystems.EventSystem:Update()

protoze jsme v okné Build Settings nenastavili, jaké scény se maji zahrnout do spousténého
programu:

Scény piidavime po jedné, pomoci tlacitka Add Open Scenes (vzdycky je potieba patfi¢nou scé-
nu oteviit), nemusime to potvrzovat zidnym z tlacitek, sta¢i okno jen zaviit kiizkem.

A pfidali jsme tam i scénu Konec, i kdyZ v ni zatim nic neni.

8.4 Zapojeni objektu Data
Rovina

Vytviteni Minci a Tyranosaurt ve skriptu Rovina by ted mélo brat v dvahu parametry hry ulo-
zené v objektu Data:

// Start is called before the first frame update
void Start()
{
Data data = FindObjectOfType<Data>();
CisloHry = data.CisloHry;
PocetTyranosauru = data.PocetTyranosauru;
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Rovina pouziva k nalezeni dat funkci FindObjectOfType<Data>().
Tyranosaurus

Podobné to udéld skript Tyranosaurus, jenom aby nemusel objekt Data hledat pii kazdém voldni
funkce Update(), presune si proménnou RYCHLOST z funkce ven a nastavi jeji hodnotu ve
funkeci Start():

float RYCHLOST = 20f;

// Start is called before the first frame update
void Start()

{
Data data = GameObject.Find("Data").GetComponent<Data>();
RYCHLOST = 10f * data.RychlostTyranosaura;

(Tyranosaurus vyuzivd jinou moznost nalezeni objektu dat.)
Mince

Kdyz Hrdina sebere Minci — a to ve svém collideru osetfuje Mince — méla by se pfipoc¢itat k cel-
kovému poctu sebranych minci. Protoze zdroveii nakonec nepotiebujeme celkovy pocet minci,
které je nutno sebrat, nebude Mince fesit kolizi s Rovinou a funkce bude reagovat jen na Hrdinu:

void OnCollisionEnter(Collision collision)
{
GameObject kdoKoliduje = collision.gameObject;
if (kdoKoliduje.tag == "Player")
{
Data data = FindObjectOfType<Data>();
data.SebranychMinci++;
Destroy(gameObject) ;

Kdybychom pfidali zvuky, tak tady by se hodilo pfehrat zvuk.
Hrdina

Hrdina by mél zvétovat udaj o tom, jak dlouho hra trva. Tedy, stacilo by ulozit si, kdy hra zacala,
a na konci odedist od aktudlniho Casu, ale rozhodli jsme se to udélat takhle. Navic bychom hraci/
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Hrdinovi méli pfidat moznost hru ukondit, tieba stiskem kldvesy Esc. Oboji se bude odehravat

ve funkci Update().

Protoze k hodnotdm objektu Data bude Hrdina pfistupovat opakovang, najde si ho jenom jednou
v metod¢ Start() a zapamatuje si ho:

Data data;

// Start is called before the first frame update
void Start()

{
data = FindObjectOfType<Data>();
rb = GetComponent<Rigidbody>();

Ve funkci Update() potom bude pficitat ¢as a pfi stisku Esc ukonéi hru:

// Update is called once per frame
void Update()

{
data.DelkaHry += Time.deltaTime;

if (Input.GetKeyDown(KeyCode.Escape))
{

UnityEngine.SceneManagement.SceneManager.LoadScene("Konec");

8.5 Scéna Konec

Scéna Konec zatim neobsahuje nic, vime, Ze tam chceme zobrazit skére a tlatitko pro piechod
do scény Uvod (mozna bychom chtéli i néco vic, ale ted ne), tak pfidime objekty UI Text a UL
Button, objekt Canvas se u toho vytvoti automaticky. Objekt Text piejmenujeme na Vysledek,
aby se ndm lépe hledal v kédu:

vg K‘unec* =
|/ Main Camera
| Directional Light
¥ | Canvas
¥ ) Button
[ JText
|,/ EventSystem
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Trochu si pohrajeme s pismem a velikosti, aby se objekty neptekryvaly (jen trochu):

Zpétky na Uvod

a tlagitku priddme skript TlacitkoZpet, ktery jednak obslouzi reakei na stisk a jednak do textu
napise vysledné skére:

public class TlacitkoZpet : MonoBehaviour

{
// Start is called before the first frame update
void Start()
{
Data data = FindObjectOfType<Data>();
int skore = 1000 * data.SebranychMinci - (int)data.DelkaHry;
GameObject vysledek = GameObject.Find("Vysledek");
vysledek.GetComponent<UnityEngine.UI.Text>().text = skore.ToString();
GameObject tlacitko = GameObject.Find("Button");
tlacitko.GetComponent<UnityEngine.UI.Button>().onClick.AddListener (KlikZpet);
}
void KlikZpet()
{
UnityEngine.SceneManagement.SceneManager.LoadScene("Uvod");
}
}
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Ty objekty Button a Vysledek bychom mohli pfedat jako parametr a nastavit v okné Inspektoru,
ale jde to i takhle. Objekt Data si vyhleddme stejné, jako jsme to uz délali v jinych mistech a pre-
chod do jiné scény uz jsme také vidéli.

Kdyz chvili hrajeme a zmédckneme klavesu Escape, vypadi to takhle:

Zpétky na Uvod

8.6 Leccos tam schazi

Schézi tam pfidat zvuky pfi sebrani mince, pfipadné pfi Gtoku tyranosaura. Neni tam ani ukladdni
a zobrazovéni nejlepsich vysledki, na to by se hodil textovy soubor nebo tfeba SQL databize.
Chybi leccos ale vSechno by uz mélo byt snadné nebo snadno dohledatelné; prochdzka konci, dél

pokralujte sami!

P.S.: Vsimli jste si, Ze tyranosarus dokaze postrkovat zdi? Jama a kyvadlo!
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Pfiloha 1: Mapa

Myslenkovd mapa mozna neni nejlepsi nastroj, protoze struktura toho, co chci ukizat, neni hie-
rarchickd — ale chtél jsem vidét néjaky celkovy pohled na to, o cem jsme mluvili

‘
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Priloha 2: Skripty

Kdyby nékdo chtél vidét pohromadé celé zdrojové texty, tak tady jsou, pro prvni (Hra) a druhy
(Tyranosaurus) projekt.

1 Hra

Pohyb.cs

using System.Collections;
using System.Collections.Generic;
using UnityEngine;

public class Pohyb : MonoBehaviour
{
public Camera mojeKamera;
public Light mojeSvetlo;
public Canvas mujCanvas;

// Start is called before the first frame update
void Start()

{
inverseMoveTime = 1f / moveTime;
rb = GetComponent<Rigidbody>();
}
float moveTime = .1f;

Rigidbody rb;

float inverseMoveTime;

protected IEnumerator PlynulyPohyb(Vector3 konec)
{

float zbyvajiciVzdalenostsqr = (transform.position - konec).sqrMagnitude;

while (zbyvajiciVzdalenostsqr > float.Epsilon)

{

Vector3 novaPozice
= Vector3.MoveTowards(rb.position, konec, rychlostPohybu * Time.deltaTime);
rb.MovePosition(novaPozice);
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zbyvajiciVzdalenostsqr = (transform.position - konec).sqrMagnitude;

yield return null;

bool probihaPohyb = false;
Vector3 cilovaPozice;

float zbyvajiciCas;

float rychlostPohybu = 5;

bool probihaOtaceni = false;
float smerOtaceni;

Vector3 cilovaOrientace;
float rychlostOtaceni = 5;

int pocetSebranychMinci = 0;

public void MinceSebrana()

{
pocetSebranychMinci++;
UnityEngine.UI.Text txt = mujCanvas.GetComponent<UnityEngine.UI.Text>();
txt.text = $"PocCet sebranych minci: {pocetSebranychMinci}";

}

void Update()
{
while (true)
{
if (probihaPohyb)
{
zbyvajiciCas -= Time.deltaTime;
if (zbyvajiciCas <= 0)

{
transform.position = cilovaPozice;
probihaPohyb = false;

}

else

{

transform.position

+= Time.deltaTime * rychlostPohybu * transform.forward;

break; // nebudeme se ptat na klavesy
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if (probihaOtaceni)

{
zbyvajiciCas -= Time.deltaTime;
if (zbyvajiciCas <= 0)
{
transform.eulerAngles = cilovaOrientace;
probihaOtaceni = false;
}
else
{
transform.Rotate (0, Time.deltaTime * rychlostOtaceni * smerOtaceni,
break; // nebudeme se ptat na klavesy
}
}

if (Input.GetKey("up"))
{
RaycastHit hitInfo;

//StartCoroutine(PlynulyPohyb(transform.position + transform.forward));
//break;

if (Physics.Raycast(transform.position, transform.forward, out hitInfo,
1))

GameObject predeMnou = hitInfo.collider.gameObject;

if (predeMnou.tag == "zed")

{
Debug.Log("nejdu - prekazka");
break;

}

if (predeMnou.tag == "mince")

{

Mince skriptMince

= GameObject.FindObjectOfType(typeof(Mince)) as Mince;
skriptMince.Seber (predeMnou) ;
break;

0);
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}
else
Debug.Log("RayCast nic nenasel");

// kdyz jsem dosel sem, tak JDU a uz se na nic neptam:
//StartCoroutine(PlynulyPohyb(transform.position + transform.forward));
//break;

if (Physics.Raycast(transform.position, transform.forward, out hitInfo, 1f)
== false)

cilovaPozice = transform.position + transform.forward;
probihaPohyb = true;

zbyvajiciCas = 1f / rychlostPohybu;
//PlynulyPohyb(cilovaPozice);

}
else
if (Input.GetKey("left") || Input.GetKey("right"))
{
smerOtaceni = (Input.GetKey("left") ? -90 : 90);
cilovaOrientace = transform.rotation.eulerAngles + smerOtaceni * Vector3.
up;
probihaOtaceni = true;
zbyvajiciCas = 1f / rychlostOtaceni;
}

break;

mojeKamera.transform.position = transform.position;
mojeKamera.transform.rotation = transform.rotation;

Rovina.cs
using System.Collections;

using System.Collections.Generic;

using UnityEngine;
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public class Rovina : MonoBehaviour
{
public GameObject PrefabZed;
public GameObject PrefabMince;

// Start is called before the first frame update
void Start()
{

Collider collider = GetComponent<Collider>();

// ziskat bludiste:
string[] blud = BLUDISTE_M;

// zjistit rozmery:
int sx = blud[0].Length;
int sz = blud.Length;

// prizpusobit velikost Roviny - a posunout ji:
transform.localScale = new Vector3(sx / 10.0f, 1, sz / 10.0f);
transform.position += new Vector3((sx-1) / 2f, 0, (sz-1) / 2f);

// nasazet Zdi a umistit a nasmerovat Hrdinu:
GameObject hrdina = GameObject.Find("Hrdina");
for (int x = 0; x < sx; Xx++)
{
for (int z = 0; z < sz; z++)
{
switch (blud[sz-1-z][x])
{
case ZED:
Instantiate(PrefabZed, new Vector3(x, 1, z), Quaternion.identity)
.transform.localScale = new Vector3(1l, 2, 1);
break;
case ,m‘:
Instantiate(PrefabMince, new Vector3(x, 1.2f, z),
Quaternion.Euler (90, 45, 0));
break;
case "'
hrdina.transform.position = new Vector3(x, 1, z);
hrdina.transform.eulerAngles = 0*Vector3.up;
break;
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case ,<‘:
hrdina.
hrdina.
break;
case ,>°
hrdina.
hrdina.
break;
case ,v‘:
hrdina.
hrdina.
break;
}
}
}
return;
}
const char ZED = ,X*;
string[] BLUDISTE_A =
{
XXXXXXXXXX !
"X <X",
"X XXXXXXX",
"X X X",
"XOXXX XXX",
XX X X",
XX XX,
"XOXXXXX X",
"X X",
XXXXXXXXXX
b
string[] BLUDISTE_M =
{
XXXXXXXXXX !
"Xomomom <x",
"X XXXXXXX!,
"X X X",
"X XXX XXX,

transform.

transform

transform

transform.

transform.
transform.

position =

.eulerAngles

.position =

eulerAngles

position =
eulerAngles

new Vector3(x, 1, z);

= -90 * Vector3.up;

new Vector3(x, 1, z);
= 90 * Vector3.up;
new Vector3(x, 1, z);

= 180 * Vector3.up;
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"X XmmmX X",
"X X XmmmX",
"X XXXXXmX",
"X mmmmX"
XXX
I
string[] Bludiste_A()

{
return BLUDISTE_A;

string[] Bludiste_B()

{
TextAsset ta = Resources.Load("BludisteB") as TextAsset;
char[] odd = { ,\r‘, ,\n" };
string[] blud = ta.text.Split(odd, System.StringSplitOptions.RemoveEmptyEntries);
return blud;
}

string[] Bludiste_N()

{
int sx = Random.Range(5, 10);
int sz = Random.Range(5, 10);
string[] blud = new string([sz];

float hustota = 0.20f;
bool uzBylHrdina = false;

for (int z = 0; z < sz; z++)
{
blud[z] = "";
for (int x = 0; x < sx; Xx++)
{
if ((x == 0) || (x == sx-1) || (z == 0) || (z == sz-1)
|| (Random.value < hustota))
blud[z] += ZED;
else
if (uzBylHrdina == false)
{
blud[z] += """;
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uzBylHrdina = true;

}
else
blud[z] += " ";

}

return blud;

// Update is called once per frame
void Update()

{

}
}
Mince.cs

using System.Collections;
using System.Collections.Generic;
using UnityEngine;

public class Mince : MonoBehaviour

{
float casDoKonceSbirani;
GameObject sbiranaMince;
public AudioClip audioClip;

// Start is called before the first frame update
void Start()
{

casDoKonceSbhirani = 0f;

public void Seber (GameObject mince)

{
sbiranaMince = mince;
casDoKonceSbhirani = 1f;
AudioSource.PlayClipAtPoint(audioClip, transform
}
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// Update is called once per frame
void Update()
{

if (casDoKonceSbirani > 0)

{

sbiranaMince.transform.eulerAngles += Time.deltaTime * 720 * Vector3.up;

//sbiranaMince.transform.position += Time.deltaTime * 3f * Vector3.up;
casDoKonceSbhbirani -= Time.deltaTime;
if (casDoKonceSbirani <= 0)

{

sbiranaMince.SetActive(false);

Pohyb skriptPohyb = GameObject.FindObjectOfType(typeof (Pohyb)) as Pohyb;
skriptPohyb.MinceSebrana();

2 Tyranosaurus
Data.cs

using System.Collections;
using System.Collections.Generic;

using UnityEngine;

public class Data : MonoBehaviour

{
public int CisloHry;
public int PocetTyranosauru;
public float RychlostTyranosaura;
public int SebranychMinci;
public float DelkaHry;

void Awake()

{
DontDestroyOnLoad(this.gameObject);
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public void ZacniNovouHru()

{
TMPro.TMP_Dropdown dropdown = FindObjectOfType<TMPro.TMP_Dropdown>();
string sCisloHry = dropdown.options[dropdown.value].text;
CisloHry = int.Parse(sCisloHry);

PocetTyranosauru = int.Parse(sCisloHry.Substring(0, 1)); // prvni cislice

RychlostTyranosaura = int.Parse(sCisloHry.Substring(l, 1)); // druha

UnityEngine.SceneManagement.SceneManager.LoadScene("Hra");

Hrdina.cs

using System.Collections;
using System.Collections.Generic;
using UnityEngine;

public class Hrdina : MonoBehaviour

{
public Camera kamera;
public Light baterka;

Rigidbody rb;
Data data;

// Start is called before the first frame update
void Start()

{
data = FindObjectOfType<Data>();
rb = GetComponent<Rigidbody>();

float rotaceOsyX = 0f;

// Update is called once per frame

void Update()

{
data.DelkaHry += Time.deltaTime;
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if (Input.GetKeyDown(KeyCode.Escape))
{

UnityEngine.SceneManagement.SceneManager.LoadScene("Konec");

float SILA = 1000f;
float POHLED = 5f;

if (Input.GetKey("up"))
{
rb.AddForce(SILA * Time.deltaTime * transform.forward);
}
float rotaceOsyY = Input.GetAxis("Mouse X");
rotaceOsyX += Input.GetAxis("Mouse Y");
// X a Y jsou spravne - doleva/doprava rotuje kolem osy Y
transform.Rotate (0, POHLED * rotaceOsyY, 0); // otocit se doleva/doprava

kamera.transform.position = transform.position;

kamera.transform.rotation = transform.rotation;

kamera.transform.Rotate(POHLED * -rotaceOsyX, 0, 0);

baterka.transform.position = kamera.transform.position;

baterka.transform.rotation = kamera.transform.rotation;
int pocetSebranychMinci = 0;

int pocetZivotu = 5;

void OnCollisionEnter(Collision collision)

{
GameObject kdoKoliduje = collision.gameObject;
if (kdoKoliduje.tag == "Tyranosaurus")
{
//TODO: zvuk
rb.velocity = (50*Vector3.up);
}
}
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Mince.cs
using System.Collections;
using System.Collections.Generic;

using UnityEngine;

public class Mince : MonoBehaviour

{
static int ZbyvaSebrat = 0;
void OnCollisionEnter(Collision collision)
{
GameObject kdoKoliduje = collision.gameObject;
if (kdoKoliduje.tag == "Rovina")
{
ZbyvaSebrat++;
}
if (kdoKoliduje.tag == "Player")
{
Data data = FindObjectOfType<Data>();
data.SebranychMinci++;
Destroy(gameObject) ;
}
}
// Update is called once per frame
void Update()
{
if (transform.position.y < -10)
{
transform.position = new Vector3(transform.position.x, 1, transform.position.z);
GetComponent<Rigidbody>().velocity = Vector3.zero;
//return;
ZbyvaSebrat--;
// zvuk
Destroy(gameObject) ;
}
}
}
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Rovina.cs

using System.Collections;
using System.Collections.Generic;

using UnityEngine;

public class Rovina : MonoBehaviour
{
public int CisloHry = 12345;
public GameObject PrefabZed;
public GameObject PrefabMince;
public GameObject Hrdina;
public GameObject PrefabTyranosaurus;
public int PocetTyranosauru = 3;

// Start is called before the first frame update
void Start()
{
Data data = FindObjectOfType<Data>();
CisloHry = data.CisloHry;
PocetTyranosauru = data.PocetTyranosauru;

Collider collider = GetComponent<Collider>();
Vector3 velikost = collider.bounds.size;

// spoleham na to, ze velikost.x==velikost.z
float minxz = -velikost.x / 2+1;

float maxxz = velikost.x / 2-1;

float kamy = 0.5f;

GameObject zed;

zed = Instantiate(PrefabZed, new Vector3(0, kamy, minxz), Quaternion.identity);
zed.transform.localScale = new Vector3(velikost.x, 1, 1);
zed.GetComponent<Rigidbody>().mass = 1000;

zed = Instantiate(PrefabZed, new Vector3(0, kamy, maxxz), Quaternion.identity);
zed.transform.localScale = new Vector3(velikost.x, 1, 1);

zed.GetComponent<Rigidbody>().mass = 1000;

zed = Instantiate(PrefabZed, new Vector3(minxz, kamy, 0), Quaternion.identity);
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zed.transform.localScale = new Vector3(l, 1, velikost.z - 4);
zed.GetComponent<Rigidbody>().mass = 1000;

zed = Instantiate(PrefabZed, new Vector3(maxxz, kamy, 0), Quaternion.identity);
zed.transform.localScale = new Vector3(l, 1, velikost.z - 4);
zed.GetComponent<Rigidbody>() .mass = 1000;

Random.InitState(CisloHry);
float K = 10f;

int pocetPrekazek = (int) (0.3 * velikost.x / K * velikost.z / K);
for (int i = 0; i < pocetPrekazek; i++)

{
float x = Random.Range(minxz+K, maxxz-K);
float z = Random.Range(minxz + K, maxxz - K);
float y = (i + 2) * K; // nechame je padat z vysky
zed = Instantiate(PrefabZed, new Vector3(x, y, z), Quaternion.identity);
zed.transform.localScale = new Vector3(K, K, K);
}

int pocetMinci = 10;
for (int i = 0; i < pocetMinci; i++)

{

float x = Random.Range(minxz + 1, maxxz - 1);

float z = Random.Range(minxz + 1, maxxz - 1);

float y = (pocetPrekazek + 2) * K + 20 + 1i;

//y =5;

Instantiate(PrefabMince, new Vector3(x, y, z), Quaternion.identity);
}

float hx = Random.Range(minxz + 1, maxxz - 1);
float hz = Random.Range(minxz + 1, maxxz - 1);
float hy = (pocetPrekazek + 2) * K + 20 + pocetMinci;
Hrdina.transform.position = new Vector3(hx, hy, hz);

// Tyranosaurus:

float minimalniVzdalenostOdHrdiny = 10f;
Vector2 hrdinaXZ = new Vector2(hx, hz);
for (int i = 0; i < PocetTyranosauru; i++)
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{
float tx;
float tz;
do
{
tx = Random.Range(minxz + 1, maxxz - 1);
tz = Random.Range(minxz + 1, maxxz - 1);
} while (Vector2.Distance(new Vector2(tx, tz), hrdinaXZ)
> minimalniVzdalenostOdHrdiny) ;
float ty = hy + 5 + 2 * §;
Instantiate(PrefabTyranosaurus, new Vector3(tx, ty, tz), Quaternion.identity);
}
}
TlacitkoStart.cs

using System.Collections;
using System.Collections.Generic;
using UnityEngine;

public class TlacitkoStart : MonoBehaviour

{
public UnityEngine.UI.Button tlacitko;

// Start is called before the first frame update
void Start()

{
tlacitko.onClick.AddListener (KLIK);

void KLIK()

{
Data data = FindObjectOfType<Data>();
data.GetComponent<Data>().ZacniNovouHru() ;
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TlacitkoZpet.cs
using System.Collections;
using System.Collections.Generic;

using UnityEngine;

public class TlacitkoZpet : MonoBehaviour

{
// Start is called before the first frame update
void Start()
{
Data data = FindObjectOfType<Data>();
int skore = 1000 * data.SebranychMinci - (int)data.DelkaHry;
GameObject vysledek = GameObject.Find("Vysledek");
vysledek.GetComponent<UnityEngine.UI.Text>().text = skore.ToString();
GameObject tlacitko = GameObject.Find("Button");
tlacitko.GetComponent<UnityEngine.UI.Button>().onClick.AddListener (KlikZpet);
}
void KlikZpet()
{
UnityEngine.SceneManagement.SceneManager.LoadScene("Uvod") ;
}
}
Tyranosaurus.cs

using System.Collections;
using System.Collections.Generic;

using UnityEngine;

public class Tyranosaurus : MonoBehaviour
{
GameObject mujHrdina;
Vector3 kdeJsemNaposledyVidelHrdinu;
Rigidbody rb;

float RYCHLOST = 20f;
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// Start is called before the first frame update
void Start()

{
Data data = GameObject.Find("Data").GetComponent<Data>();
RYCHLOST = 10f * data.RychlostTyranosaura;
mujHrdina = GameObject.FindGameObjectWithTag("Player");
kdeJsemNaposledyVidelHrdinu = Vector3.zero;
rb = GetComponent<Rigidbody>();

}

bool uzDopadl = false;
void OnCollisionEnter(Collision collision)

{
if (collision.gameObject.tag == "Rovina")
{
uzDopadl = true;
}
}

// Update is called once per frame
void Update()

{
if (uzDopadl == false)
{
return;
}

float BLIZKO = 1f;
float KROK = 2f;

// jestli vidim Hrdinu:
RaycastHit hit;

Vector3 smer = mujHrdina.transform.position - transform.position;

if ((Physics.Raycast(transform.position, smer, out hit))

&& (hit.collider.gameObject.tag == "Hrdina"))
{
kdeJsemNaposledyVidelHrdinu = mujHrdina.transform.position;
rb.velocity = Time.deltaTime * RYCHLOST * smer.normalized;
}
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else // pokracovat ve smeru, pokud tam jeste nejsem
if ((transform.position-kdeJsemNaposledyVidelHrdinu).sqrMagnitude>BLIZKO)
{
smer = mujHrdina.transform.position - transform.position;
rb.velocity = Time.deltaTime * RYCHLOST * smer.normalized;
}
else // uz jsem tam dosel a Hrdinu nevidim => zvolit si novy cil
{
float uhel = Random.Range(0f, Mathf.PI * 2);
kdeJsemNaposledyVidelHrdinu
= new Vector3(KROK * Mathf.Sin(uhel), 0, KROK * Mathf.Cos(uhel));
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